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Welcome to Realm Studio 
Welcome 
Thank you for your interest in Realm Studio. Realm Studio is an open-source Windows 

application intended for making fantasy maps for gamers, world builders, authors, and anyone 

else that would like to make nice-looking maps quickly and easily. 

Using Realm Studio is completely free of charge. Just download RealmStudio.msi, then double-

click it to install the Realm Studio application and a default set of assets (symbols, textures, 

frames, boxes, and so on) for your maps. More information on map assets is in the sections 

below. 

Support 
Because Realm Studio is open source and free, support is limited. This Help file provides all the 

information needed to create maps using Realm Studio, but if you have questions, feature 

suggestions, or bugs to report, please email support@brookmonte.com. 

Installing Realm Studio 

Computer Requirements: 
• Realm Studio requires Windows 10 (version 10.0.26100.0) at minimum. 

• Realm Studio uses the graphics card (GPU) of the computer to speed up drawing of your 

Realm Map and 3D models, so your computer should have a good graphics card, 

equivalent to an Nvidia GTX 1080ti or better. Less capable graphics cards may still 

work, but with reduced performance. 

• Your computer will probably need at least 8GB of memory, and more is better. 16GB is 

enough for most maps, and 32GB or more is ideal. Large maps with lots of features 

require more memory.  

• The Assets installed with Realm Studio require about 280 MB of hard drive space on the 

same hard drive as your Documents folder. By default, Realm Studio creates a 

RealmStudio subdirectory within your Documents folder to store assets, maps, and other 

data used by the program. Depending on the number of Realm Maps that you create, 

that folder can use a significant amount of space, so you should plan on Realm Studio 

taking up as much as 1GB of hard drive space. 

• If you have previously installed Realm Studio, keep a backup copy of all your assets 

(symbol collections, etc.) as they will be overwritten during installation. You can restore 

them to the Realm Studio Assets folder from your backup. 

Installation: 
• Download the RealmStudio.msi installer file from Github. The RealmStudio.msi file is 

located at https://github.com/PeteNelson372/RealmStudio under Releases. Only the 

latest release is supported. 

https://github.com/PeteNelson372/RealmStudio
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• The Realm Studio source code is also hosted on Github. If you are a developer and want 

to download and build Realm Studio yourself, the source code is located at 

https://github.com/PeteNelson372/RealmStudio. You will need Visual Studio 2022 to 

build the application. 

• After the RealmStudio.msi file is downloaded, run it by double-clicking it from File 

Explorer or from the download dropdown in your browser: 

 

• Since Realm Studio is a new application, it is likely that you will get a security warning 

from Windows Defender, saying that it has prevented you from running an unknown 

application. If that happens, you can override Windows Defender to run the 

RealmStudio.msi installer. 

• Use the installation program to install the Realm Studio application and mapmaking 

assets. 

 

• The Realm Studio installation program (which is launched by the RealmStudio.msi file 

when you run it) will install Realm Studio and some mapmaking assets to your 

computer. The mapmaking assets are installed to your Documents folder in a subfolder 

called RealmStudio/Assets. 

• Realm Studio requires Windows .NET 8.0 to run. If your computer does not have 

the .NET 8.0 libraries installed, the Realm Studio installation program will launch 

installers to install them for you. 

• Once the Realm Studio installation program completes running, you can launch Realm 

Studio and begin making maps. The rest of this document goes over how to use Realm 

Studio to make maps, how to install additional assets, and other information you may 

need. If you have any problems, find bugs, or have suggestions for improvements, please 

https://github.com/PeteNelson372/RealmStudio
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email support@brookmonte.com or open an issue on Github at 

https://github.com/PeteNelson372/RealmStudio/issues. 

• Thank you! Your feedback and support for Realm Studio are very much appreciated. 

Have fun making beautiful maps! 

 

  

mailto:support@brookmonte.com
https://github.com/PeteNelson372/RealmStudio/issues
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Using Realm Studio to Make Maps 
An Overview of Realm Studio 

Realm Studio Features 
 

Realm Studio was designed to make creating beautiful maps easy and fast. 

Some of the Realm Studio Features: 

• Quickly style your maps using a variety of attractive themes provided with Realm 

Studio, or define your own themes 

• “Paint” landmasses on your map with automatic generation of attractive shoreline 

textures 

• Automatic generation of random continents, islands, archipelagos, atolls, regions, or 

an entire world 

• Draw freshwater lakes and rivers, and automatically generate random lakes 

• Set textures for the map background and ocean with scaling, mirroring, and opacity 

• Draw paths (roads, tracks, etc.) with a large variety of styles. Pin roads to be straight 

horizontal or vertical, or pinned to any angle in 5-degree increments. 

• Place symbols individually or “paint” groups of symbols to create forests, mountain 

ranges, and so on 

• Automatic color randomization of symbols to make them look more realistic 

• Use symbols in a variety of raster formats or use SVG vector symbols that can be 

scaled to any size without looking blocky 

• Create attractive map labels using any text font installed on your computer or any of 

a set of fonts installed with Realm Studio 

• Style labels using label presets that are part of a theme or define your own 

• Create curved labels that follow an arc or a freeform curve 

• Add a frame to your map that can be scaled and tinted 

• Add a square or hex grid to your map; change color, size and line thickness 

• Easily measure distances and areas on your map 

• Draw regions on your map in various styles. Pin region boundaries to landform 

coastlines easily and instantly 

• Easily create grayscale heightmaps of your landforms and view the heightmaps in 

3D, with near real-time updates to the 3D view as you paint the heightmap 

• Make maps from 500x500 pixels up to 8192x8192 pixels 

• Easily add new assets (symbols, boxes, frames, etc.) to use on your maps 

• Use a powerful name generator to create a random name for objects on your map 

• Create and save descriptions of objects on your map, with AI integration to assist in 

creating the descriptions 

• Realm Studio is 100% free and open source. No royalties or payments of any 

kind are ever required. 
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How Realm Studio Works 
Realm Studio constructs realms (maps) in many independent layers. The controls to draw or 

paint each layer are displayed on tabs that represent some aspect of your map – ocean, land, 

fresh water, symbols for mountains, trees, houses, etc., as well as paths, labels, map grids, and 

so on. Realm Studio was modeled on Wonderdraft, and many of Realm Studio’s features work 

like those of Wonderdraft, so if you are familiar with that application, you will quickly 

understand Realm Studio. You will “paint” many of the features of your map using a dotted-line 

circle cursor. Other features you select or place using the usual Windows arrow or cross cursor. 

Realm Studio was designed to be easy to use, so figuring out how the controls work won’t take 

long. 

Often, clicking a button will change the Drawing Mode of Realm Studio. The current Drawing 

Mode is displayed in green text below the map on the left. Make note of the current Drawing 

Mode as you create your map. It will tell you what operation Realm Studio will perform. 

When Realm Studio Starts 

Configuring Your Realm 
When Realm Studio starts, it displays a “splash screen” for a few seconds (you can dismiss the 

splash screen by clicking on it, if you don’t want to wait). It then displays the main window and 

loads the assets you can use when creating your maps. 

After the assets are loaded, a dialog box titled “Realm Configuration” is shown. The dialog 

allows you to select the type of realm (map), the size of the map in pixels, the size of the map 

(map area) in real world units (square miles, kilometers, meters, feet, etc.), and the initial 

theme for the map. The theme can be changed after it is created. There is more information on 

themes later. 

You should give your realm (map) a name by entering the name in the text box at the top of the 

Realm Configuration dialog. If you do not give your realm a name, it will be called “Default.” 

You can change the name of your realm later, if you don’t give it a name in the Realm 

Configuration dialog. 
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At this time, changing the Realm Type only changes the default Map Area Units, but in future 

versions, changing the Realm Type will cause other changes to the application functionality to 

support creation of specialized maps for building interiors, dungeons, solar systems, etc. 

After you have selected the Realm Type, Realm Map Size, Realm Map Area, and Realm Map 

Theme on the Realm Configuration dialog, click the OK button to display the Realm Studio 

Main Window. Clicking Cancel will close Realm Studio. 
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The Realm Studio Main Window 
 

 

The Main Window is where you will paint your Realm Map. Based on the Realm Map Theme 

you chose in the Realm Configuration dialog, background texture and vignette type and color, 

and other textures and colors are selected and applied to your Realm Map. Of course, you are 

free to choose different texture, colors and other features of your map at any time. 

On the far left of the Main Window is a set of tabs labeled Background, Ocean, Land, Water, 

Paths, Symbols, Labels, Overlays, Regions, and Drawing. Selecting a tab will change the 

controls displayed just to the right of the tabs and in the panel on the far right of the Main 

Window. The controls that are displayed allow you to add, edit, and delete the features of that 

layer of the Realm Map. 

The rest of this document describes the controls and features of Realm Studio in detail, so if you 

have questions about how a feature works or what it does, please refer to the sections below. 
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The Title Bar Controls 
 

There are several controls in the title bar of the Realm Studio application that give you quick 

access to some basic functions. 

 

The Autosave Switch 

The Autosave switch enables and disables the Autosave function of Realm Studio. When 

enabled, Realm Studio will periodically save a backup copy of your map. The backup copies are 

saved in your Documents folder in a subdirectory named “RealmStudio/Realms/autosave.” More 

information on Realm Studio directories and the Autosave functionality is below. 

The File Open Icon 

The File Open icon opens a Windows File Open dialog to allow you to open a previously saved 

map. 

The File Save Icon 

The File Save icon opens a Windows File Save dialog to allow you to save the map you are 

currently working on. The file name defaults to the name of your realm (map), if it was set in 

the Realm Configuration dialog or in the Realm Properties dialog. 

The UI Switch 

The UI switch allows you to change the look of the Realm Studio user interface from the default 

dark borders to light borders. At this time, switching the UI look has not been implemented. 
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The Main Menu Bar 

 

The Application Tools 
On the right side of the Main Menu Bar are icon buttons for tools that are common to more than 

one tab or are independent of the tabs. 

 

The 3D Model Viewer Icon 

Clicking the 3D Model Viewer icon (the gold-colored cubes) open the Realm Studio 3D Model 

Viewer window. The 3D Model Viewer allows you to open and view, rotate, zoom, and pan 3D 

models in several formats: Stereolithography format (.stl), Wavefront OBJ (.obj), Object 

File Format (.off), Autodesk 3DS format (.3ds), and Lightwave 3D Object format (.lwo). 

Models can be saved in Wavefront OBJ format. The 3D Model Viewer is used when viewing 

grayscale height maps in 3D and when viewing a world globe. 

 

 

The Eyedropper Icon 

Clicking the Eyedropper icon will cause the Drawing Mode to change to Select Color and the 

cursor to change to an eyedropper. You can click anywhere on the map to select the color at that 

location. If you are on the Ocean tab, the Land tab, or the Water tab, the selected color will be 

set on the Color Brush button. 
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The Plus Icon 

The Plus icon opens the Color Selection dialog. Selecting a color from the dialog will add it to 

the set of custom colors on the Ocean tab, the Land tab, or the Water tab. 

The Area Selection Icon 

Clicking the green Area Selection Icon allows you to select a rectangular area on the map. 

Several functions require that an area on the map be selected, such as Copy/Cut/Paste, creating 

a Detail Map, and others. 

The File Menu 

Starting a New Map 

Choosing the New option from the File menu allows you to create a new map. If you are working 

on a map, you will be prompted to save it before creating a new one. When you select this 

option, the Realm Configuration dialog will be displayed to let you choose the map size, area 

size, etc. as shown above. 

Opening a Map 

Choosing the Open option from the File menu will open a Windows File Open dialog to allow 

you to open a previously saved map. Realm Studio maps are saved with a .rsmapx extension, 

and they are XML files, so you can open a Realm Studio map with Notepad or an XML editor 

application to view the map structure. Though they are XML files, it is not recommended that 

you edit the Realm Studio map XML directly, as the map structure could be damaged, rendering 

it unopenable by Realm Studio. 

Saving a Map 

Choosing the Save and Save As options from the File menu will open a Windows File Save 

dialog to allow you to save the map you are working on. By default, your maps will be saved in 

your Windows Documents folder in a subfolder called “RealmStudio/Realms. You are free to 

change the location of your saved maps, but it is recommended that you save them to the 

default location. If future functionality changes require the structure of Realm Studio maps to 

change, any map upgrade functions will be able to locate your maps more easily if they are 

saved to the default location. 

  



November 22, 2024 

 

P a g e  13 | 84 

Exporting a Map 

 

Choosing the Export option from the File menu opens the Export Realm dialog. The Export 

Realm dialog lets you export your Realm Map in various forms. Maps can be exported as an 

image file in several formats: Portable Network Graphics (.png) file, Joint Photographic 

Experts Group (.jpg) file, Windows bitmap (.bmp), or Graphics Interchange Format (.gif). 

You can also choose to export the Realm Map as an upscaled image at two times the pixel 

resolution (two times width and two times height) of the Realm Map. You can choose any of the 

Export Formats as image export. 

Currently, export options are limited: the size of the exported file (resolution), color depth, 

transparency color, and so on cannot be changed. Additional options may be added to the export 

function in the future. 

Selecting the Map Layers option will export the Realm Map as a ZIP file (.zip) containing 

a .png file for each layer of the map. There are 18 images written into the .zip file; however, 

the number of images included in the .zip file may change as application features are added or 

changed. 

Selecting the Grayscale Height Map option allows you to export the Realm Map as a grayscale 

(“black and white”) image. Grayscale height maps are used in many different 3D modeling and 

graphics applications to create 3D pictures and models of landscapes. There is much more about 

height maps and 3D models and 3D views of Realm Maps below. 

Selecting the Height Map 3D Model option allows you to export your Realm Map in the 

Wavefront OBJ (.obj) 3D model format. This format is one that can be read and viewed by 

many 3D modeling and 3D viewing applications, like MeshMixer. (You can download 

MeshMixer here: https://apps.autodesk.com/FUSION/en/Home/Index). Realm Studio also 

includes a basic 3D viewer that can be used to view your entire map, selected Landforms, or a 

selected area of your Realm Map as a 3D model. Viewing your map as a 3D model requires you 

to create a height map for it. These functions are described in much more detail below. 

https://apps.autodesk.com/FUSION/en/Home/Index
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Printing a Map 

Realm Studio includes functionality for you to preview your map and send the map to your 

printer, with options to choose the printer to print the map on, the number of copies to print, to 

print the map in portrait or landscape, to print in color or grayscale, select paper size, print 

quality, and margins, and to scale your map or fit it to a selected number of pages. By default, 

the map will be scaled to fit to one page on the default paper size for the selected printer. Be 

aware that some printers do not support printing without a margin, so if you want to print your 

map on multiple pages, it may not be possible to eliminate a border around each page. 

 

 

The Edit Menu 

Undo/Redo 

Many (but not all) of the functions in Realm Studio can be undone/redone using either the Edit 

Undo/Redo menu options or the standard ctrl+z and ctrl+y keyboard shortcuts. 

Cut/Copy/Paste 

You can use the Area Selection icon to select an area on the map and then copy or cut symbols, 

paths, and water features (including lakes and rivers) in the selected area. The map components 
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that are cut or copied can be pasted at a new location. The new location for the components is 

wherever the mouse cursor is located. 

The Realm Menu 

The Realm Properties Dialog 

The Realm Properties dialog displays information about the map you are currently working on 

and allows you to change the name of your realm. 

 

 

Changing the Map Size 

Realm Studio provides functionality to resize your map. The Resize Realm dialog shown below 

lets you choose a new size for the map. If the new map size is smaller than your current map, 

the current map is called down to fit the new map size. If the new map is larger than your 

current map size, you can choose to scale the existing map up to fit the new size, or for the 

existing map to take up a portion of the new map. The Anchor and Scale buttons specify where 

on the new map the existing map will be placed. The Scale Map to New Size checkbox specifies 

whether the existing map will be scaled to fit the new size or keep its original size and take up a 

portion of the new map. The new map will include all of the features of the existing map 

(landforms, water features, symbols, paths, and labels) of the existing map, scaled 

proportionally to the new map size. 

Before resizing the map, Realm Studio will prompt you to save the existing map so that you can 

revert to the existing map, if you need to. 
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Creating a Detail Map 
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Realm Studio also allows you to create a Detail Map from an existing map. To create a Detail 

Map, first select a portion of the existing map using the Area Selection button on the right side 

of the Main Menu Bar. It looks like this:  

 

After selecting the map area from which to create the Detail Map, select Create Detail Map… 

from the Realm option on the Main Menu. The dialog shown above will be displayed. The dialog 

allows you to change the location and size of the selected area, what features of the existing 

map to include in the Detail Map, how much to scale the detail map, and to give the Detail Map 

a name. Once the parameters in the dialog are set as you’d like, click the OK button. If the 

existing map has not been saved, you will be prompted to save it. After that, the new Detail 

Map will be created and displayed, with the selected features included, scaled to fit the Detail 

Map. 

Tracing the Outline of an Image 

Realm Studio lets you select any raster image (in the same formats that can be exported), find 

the perimeter of the objects in the image, and then create a landform from the largest traced 

object in the image. Because images can vary so much, the process is not reliable. Sometimes, 

editing the image to increase contrast, remove small artifacts, and remove interior colors and 

features can improve the results. Here’s an example of a map of the continental United States 

traced and converted into a landform. 
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Creating and Viewing Grayscale Heightmaps 

Realm Studio includes functionality to view and create grayscale heightmaps for the landforms 

on your map. To create a heightmap, first paint landforms on your map as described in the 

sections below. Once you’ve created your landforms, select Display Height Map from the 

Realm option on the Main Menu. When selected, the Land tab will be displayed, but with 

controls for painting and viewing a grayscale heightmap. 

 

 

 

 

 

 

 

The process for creating a grayscale heightmap is similar to painting color on a 

landform. Clicking the Increase button will set the Drawing Mode to Increase 

Map Height. When in this mode, holding the left mouse button while moving 

the mouse will lighten the color of the heightmap, increasing the height of the 

landform at that location. Conversely, clicking the Decrease button will set the 

Drawing Mode to Decrease Map Height. Holding the left mouse button and 

moving the mouse will darken the color of the heightmap, decreasing the 

landform height at that location. The Brush Strength Up/Down control value 

indicates the rate at which the color is changed as you move the mouse. A 

smaller value changes to heightmap shade more slowly. Grayscale painting of 

heightmaps is clipped to the landform boundaries. 

Clicking the 3D View button will open the 3D Viewer window with a 3D view of 

the landforms on your map derived from the grayscale heightmap. You can 

zoom, pan, and rotate the 3D view of your map. 

When the Update 3D View switch is enabled, every time you release the left 

mouse button, the 3D view is updated. However, near-real-time updates impact 

performance while painting the height map, so you can disable updates if 

performance is too slow. Another way to improve performance while viewing the 

3D model is to select the landform or use the Area Select button to select an 

area of your map. The 3D view will only show the selected landform or area. 

Landforms on your map and the map boundaries are outlined in a green dotted 

line to help you see them more easily. 

To go back to the normal map view, uncheck the Display Height Map menu 

option from the Realm main menu option. 

 



November 22, 2024 

 

P a g e  19 | 84 

The Heightmap View 

 

A 3D view of a landform heightmap. 
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The World Globe View 

Realm Studio allows you to view your map as a world globe floating in space using the 3D 

Viewer and to record AVI video of the globe rotating. The 3D World Globe View has a lot of 

different options, so it is covered in detail in the section titled “The 3D World Globe View.” 

The Assets Menu 
There are several types of “assets” that Realm Studio loads and uses to allow you to create 

maps. 

• Boxes are used to outline and emphasize labels that are placed on the map. 

• Brushes are used to paint colors onto ocean areas, landforms, and water features (lakes, 

rivers, and so on). 

• Frames are used as borders around your map. 

• Icons are used in the user interface of Realm Studio. 

• Label presets are XML files that describe preset formats for labels (font, size, color, 

outlining, and glow). You can create your own label presets in Realm Studio in addition 

to the default presets provided. The label presets are associated with the selected 

Theme, so each theme has its own presets, and label presets for each Theme do not 

conflict, even if they have the same name. 

• Name Generators (and name bases) are files that drive the generation of random 

names that can be used in labels. If you can’t think of a name for a continent, river, 

island, lake, or anything else on your map, the Name Generator function can generate 

one for you. Hundreds of thousands of unique names can be generated. 

• Symbols are small images of objects that can be placed on your map (houses and 

buildings of all types, trees, bushes, grass, and other kinds of vegetation, mountains, 

hills, volcanoes and other landscape features, as well as other kinds of objects). Much 

more information on symbols is in the sections below. 

• Textures are bitmaps that are used as the background for the map, for ocean areas, for 

landforms, and for 3D and World Globe views. 

• Themes are XML files that define the look of a map: textures, colors, frames, label 

styles, and more. You can define your own themes in addition to those that are provided. 

Themes are described in more detail below. 

• Vectors are used to define some user interface elements, like some path styles. 

Creating Symbol Collections 

To use symbols in Realm Studio, they must be part of a Symbol Collection. A Symbol Collection 

is defined by an XML file within a subdirectory of the Assets/Symbols directory created when 

Realm Studio is installed. Realm Studio provides a dialog for creating Symbol Collections, 

which is described in the Realm Studio Assets and Symbol Collections section below. 

Importing Assets 

Realm Studio can use most assets (symbols, frames, boxes, and so on) that were developed for 

Wonderdraft. You can import Wonderdraft assets from the Cartography Assets site and then 

import them into Realm Studio. Realm Studio provides dialogs for importing downloaded assets. 

https://cartographyassets.com/
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The dialogs are described in detail in the Realm Studio Assets and Symbol Collections section 

below. 

Reloading Assets 

When new assets are imported or new symbol collections are created, Realm Studio must reload 

the assets to be able to use them. Selecting Assets -> Reload All Assets from the main 

menu will load all the assets from the Realm Studio Assets folder. 
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The Theme Menu 
Choosing the Theme menu option on the main menu opens the Save or Apply Theme dialog. 

This dialog allows you to select a theme, select which settings the theme will change, apply the 

selected theme to the map settings, and create a new theme from the currently selected map 

settings in the Realm Studio user interface. 

 

To apply a theme, select it from the dropdown, select which settings you want to change, then 

click Apply. The settings from the theme will be applied to the associated user interface controls 

and to the current realm map. 

To create a new theme, set all the controls in the Realm Studio user interface to the values you 

want saved in the theme – colors, textures, label, coastline pattern, and so on. Then click the 

Save As button on the dialog. Another small dialog will be displayed to let you enter a name for 

the new theme. Enter the name, then click OK. The new theme will be created with the name 

you entered. You must reload the Realm Studio assets before the new theme will be available. 
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The Options Menu 

Changing User Preferences 

There are several preferences that you can set that change how Realm Studio works and where 

it finds and saves files. The preferences that you set are saved, so Realm Studio will use the 

value that you set whenever it is opened. The user preference dialog looks like this: 
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• The Default Realm Directory preference tells Realm Studio where to save your maps. 

When Realm Studio is installed, this value is set to a subfolder of your Windows 

Documents folder called RealmStudio/Realms. If you change this value, Realm Studio 

will set the default location of saved maps to the folder that you select. 

• The Measurement Units preference allows you to set the default measurements to 

either US Customary units (inches, feet, miles) or metric units (centimeters, meters, 

kilometers). 

• The Realm Assets Directory preference sets the location of Realm Studio assets folder. 

When Realm Studio is installed, this value is set to a subfolder of your Windows 

Documents folder called RealmStudio/Assets. If you change this value, Realm Studio 

will load assets from the folder you select. Be careful when changing this value. If Realm 

Studio cannot locate the assets it requires, application errors will occur. 

• The Autosave Realm switch enables or disables automatic saving of backup copies of 

your map. When enabled, Realm Studio periodically saves a backup copy of your map. 

The interval between automatic backups is set by the Autosave Interval trackbar. A 

maximum of five backup copies are kept; although, at times six may be retained for a 

short period of time. 

• The Autosave Directory preference sets the folder in which backup copies of your map 

are saved. When Realm Studio is installed, the folder is set to a subfolder of your 

Windows Document directory called RealmStudio/Realms/autosave.  It is not 

recommended that you change the folders in which your maps are saved or the backup 

location, as future functionality will allow you to restore your map from a backup in case 

of an application error or a problem with the map. 

• The Autosave Interval trackbar allows you to set the time between automatic backups 

from five minutes up to thirty minutes in five-minute increments. 

• The Play Sound on Save switch allows you to enable or disable playing of a sound 

indicating that your map has been successfully saved. 

• The Default Export Format preference allows you to indicate your preferred format 

for maps that are exported as an image file. 

• The Draw Contours While Painting switch is important when creating large maps 

(larger than 4K Ultra HD or 3840x2160 pixels). By default, Realm Studio calculates the 

boundaries of landforms while you are painting the landform. You can see this 

happening as you paint. On very large maps, calculating landform boundaries can cause 

landform painting to lag and affect performance. By turning this feature off, calculation 

of landform boundaries is delayed until you release the left mouse button, which 

improves performance somewhat. 

• When painting colors on a landform, Realm Studio clips the color brush to the outline of 

the landform (preventing you from accidentally painting land colors onto ocean and 

water areas. The Clip Coloring to Landform switch turns off the clipping, so landform 

coloring can overlap ocean and water areas. This may improve performance somewhat. 

• The Default Map Size radio buttons allow you to set the default size of maps that you 

create. 
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Setting the Name Generator Configuration 

Realm Studio has a built-in random name generator function that uses “name generators” and 

“name bases” that are in the same format as those used by Wonderdraft, and you can download 

additional name generators and name bases from Cartography Assets and install them in the 

Realm Studio Assets folder to be used by Realm Studio. You can also easily create your own 

name generator or name base files using a simple text editor (like Notepad) and save them into 

the Realm Studio Assets directory. The format of these files is described in the Technical 

Information section below. 

The set of name generators and name bases installed with Realm Studio allows hundreds of 

thousands of different names to be generated in dozens of real and fantasy languages. In some 

cases, you may want to limit the random names generated to one or more specific languages or 

only for bodies of water, or only from specific name generators or name bases. The Name 

Generator Configuration dialog (opened from the Options -> Name Generator 

Configuration… menu option) lets you do that. 

 

You can select specific name generators or name bases to use or select specific languages. 

Clicking the Generate Names button will generate ten random names based on the selections 

you’ve made. A rolling list of the last thirty random names generated is kept. Selecting a name 

and clicking the Apply button will copy the selected name to a label being created. Clicking the 

Clipboard button will copy the selected name to the clipboard so you can paste it wherever you 

like. If no name is selected, all the names in the list are copied to the clipboard. 
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Generating Names for Bodies of Water 

To generate names only for bodies of water, deselect all Name Generators and Namebases. In 

the Name Generators list, select only the “Bodies of Water” Name Generator. Select the 

Languages for the names of the bodies of water you would like to generate, then click Generate 

Names. Note that only the names of the bodies of water are in the language(s) you select. The 

type of the body of water is in English, e.g. “ocean,” “lake,” “swamp,” and so on. So, for example, 

an ocean name generated with Chinese selected might be “Huangzhou Ocean.” You can select as 

many languages as you like when generating bodies of water, but at least one must be selected. 

The Help Menu 

Displaying this Help File 

Selecting the Help -> Contents menu option opens this Help file in your browser from the 

RealmStudioDocs Github repository web pages created for the Realm Studio documentation. 

The URL is: https://petenelson372.github.io/RealmStudioDocs/. 

The About Dialog 

Selecting the Help -> About menu option opens the About dialog for Realm Studio. The About 

dialog displays important implementation, copyright, and licensing information, as well as 

credits for libraries and images used to create Realm Studio. Links to the Realm Studio source 

code on Github are shown, as are links to release notes and to create an email to the Realm 

Studio support email address (which is support@brookmonte.com). 
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Painting Maps with Realm Studio 

The Realm Studio Main Window 
 

 

• At the center of the Realm Studio main window, the Map Area is where the map is 

displayed as you draw/paint it. 

• On the left side of the main window, the Tab Controls organize the Realm Studio 

functions according to the features of the map. 

• At the top of the main window is the application Title Bar and the title bar controls. 

• Just below the title bar is the application Main Menu. On the right side of the Main 

Menu bar is a set of icon buttons giving access to application tools and functions that are 

used on many tabs or are independent of the functions on the tabs. 

• To the right of the Map Area is a panel in which additional drawing controls are 

displayed. The controls displayed on the Additional Drawing Controls panel change 

when tabs are selected. 

• At the bottom-right of the Main Window are controls that control the zoom level of the 

map. The map can also be zoomed by holding down the Control Key and rolling the 

mouse wheel. 

• At the bottom of the Main Window are controls showing the status of the map and the 

current Drawing Mode. 
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• Just underneath and on the right of the Map Area are scrollbars that allow you to pan 

the map right/left and up/down. The map can also be panned by holding down the 

middle mouse button (often the mouse wheel). 

Selecting a tab causes Realm Studio to display a set of controls on the left and right sides of the 

main window (in the Tab Controls and Additional Drawing Controls areas) that give you access 

to functions for creating maps. Realm Studio maps are organized in layers, and drawing on a 

layer does not affect the other layers. There are many more layers than just the ten implied by 

the tabs, but for the purposes of creating maps, you can think of the map as having ten layers, 

one for each tab. For display, each of the layers is composited into a final image that is 

displayed in the map area of Realm Studio. 

The Tab Controls area on each of the tabs is divided into two sections. On the left is a set of 

controls for selecting colors, textures, and other options that affect what will be drawn or 

painted on the map for the selected map layer. On the right side of the Tab Controls area, 

immediately next to the Map Area is a set of buttons that (usually) either change the Drawing 

Mode of Realm Studio or apply a selected value (texture, color, etc.) to the map. Each of the 

controls and buttons is described in more detail below. 

The Realm Studio Tabs 

 

The Background Tab 

Realm Studio allows you to set a background texture for your map. Usually, this is not 

necessary, as your map will have an ocean texture or be filled with a landform that has a 

texture. However, the option is available if you choose to use it. 

Setting a Background Texture 

To set a background texture, scroll through the available background textures using the arrow 

buttons at the bottom of the texture preview window until you find the one you want to use, 

then click the Fill button. To clear the background texture, click the Clear button. You can scale 

and mirror the background texture to achieve the desired effect. Setting the background texture 

scale to zero will remove it. 

The Map Vignette 

The map vignette is the shaded area around the outer edges of the map. You can change the 

color of the vignette and the strength of the vignette (how dark it is and how much of the map it 

fills). The controls for the vignette are shown on the Background tab, but it is painted on top of 

most of the other map layers, so the vignette color and strength may affect the appearance of 

other things painted near the edges of your map. 

To change the color of the vignette, click the Color Palette button in the Vignette box. 



November 22, 2024 

 

P a g e  29 | 84 

 

A Color Selection dialog will be displayed. 

 

Use the controls in the Color Selection dialog to select a color, then click OK. The selected color 

will be shown as the background of the Color Palette button and applied to the map vignette. In 

general, buttons with the palette icon allow you to select a color for something to be drawn or 

painted on your map, and the process for selecting a color is the same throughout Realm Studio. 

The “strength” of the map vignette (how dark it is and how much of the map area it fills) can be 

changed by adjusting the trackbar slider in the Vignette box. The appearance of the vignette 

changes as you move the slider. If you don’t want a vignette for your map, adjust the slider all 

the way to the left to make the vignette strength zero. 

The vignette shape can be changed using radio buttons under the Strength slider. The vignette 

can be oval or rectangular. An oval vignette shades the corners of the map, leaving an oval area 

in the center of the map unshaded. A rectangular vignette shades the outer edges of the map, 

leaving a rectangular area in the center of the map unshaded. Try different variations of 

vignette color, shape, and strength to get the look you want. 
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The Ocean Tab 

Clicking the Ocean tab displays the controls for setting the look of the ocean areas on your map. 

The ocean area of your map can have a texture applied and/or a color applied. In addition, you 

can “paint” on the ocean to make it look however you want. 

The Ocean layer is on top of the map Background layer, but under all other layers, so when you 

paint land areas and create other objects on the map (grids, map scales, labels, etc.) they are 

show “on top” of the Ocean layer. 

Setting an Ocean Texture 

Applying a texture to your Ocean layer works the same way as it does for the Background. 

Select a texture from the texture preview box on the Ocean tab, then click the Apply button 

with the Paint Roller icon. Remove the ocean texture by clicking the Remove button. You can 

change the opacity of the ocean texture using the Opacity trackbar. You can also scale and 

mirror the Ocean texture to get the look you want. 

Lowering the opacity of the Ocean texture (increasing its transparency) lets the Background 

texture show through, if one has been set. This has the effect of combining the textures, which 

can create interesting effects. 

Setting an Ocean Fill Color 

You can fill the entire Ocean area with a selected color. Select the color you want to fill the 

Ocean area with by clicking the Color Palette button in the Color box. It works the same way as 

the Color Palette button on the Background tab. When you’ve selected the color, click the Fill 

button. The entire Ocean area will be filled with the color you’ve selected. Clear the color by 

clicking the Clear button. 

The ocean fill color can be combined with the ocean texture. By selecting a color that is more 

transparent (the Alpha value in the Color Selection dialog is low), the ocean texture will show 

through the ocean fill color, in effect letting you apply a color overlay “on top” of the texture. 

This technique is especially effective when used to apply color to a black-and-white or grayscale 

texture. 

Painting on the Ocean Layer 

In addition to the controls displayed in the tab control on the left side of the main window, 

clicking the Ocean tab will display controls in the Additional Drawing Controls panel on the 

right side of the main window. These controls can be used to paint on top of the ocean texture 

and on top of the ocean fill color. To paint on top of the ocean layer, click the Color button with 

the paint brush icon. The Drawing Mode of Realm Studio will be changed to Ocean Paint (as 

shown in the green text at the bottom left of the main window in the Map Status and Drawing 

Mode area), and the cursor will be changed to a dotted-line circle with crosshairs at the center. 
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The Ocean Tab 

Painting Controls 

 

 

At the top of the Painting Controls, you can select either the soft-

edged brush or the hard-edged brush. Future versions of Realm 

Studio will have more brush styles to select. 

 

The three sliders control the size of the brush (reflected in the size 

of the dotted-line circle cursor), the “brush velocity” and the eraser 

size. 

The Color and Erase buttons set the Drawing Mode to either paint 

on the ocean or erase the painted color from the ocean. Erasing 

painted color does not affect the ocean background texture or color. 

As you paint or erase, you can undo/redo what you’ve painted by 

using the Undo/Redo menu options or using the usual crtl+z and 

ctrl+y keys. 

The Color Palette button lets you select the color to be painted on 

the ocean. Clicking it will display a Color Selection dialog as 

shown earlier. 

The set of buttons here are color preset buttons. There are four 

predefined color presets. The white boxes are for preset colors that 

you can define. At the top right of the main menu bar (just above 

the Ocean Tab Painting Controls) are two buttons: 

 

Clicking the “+” button opens the Color Selection dialog. Choosing 

a color in the Color Selection dialog and clicking “OK” will assign 

the selected color to the first color preset button that doesn’t 

already have a color assigned. Clicking a color preset button that 

has a color assigned will set the selected color (shown by the 

background color of the Select Brush Color button changing to the 

preset color). 

Clicking the eyedropper button changes the cursor to an 

eyedropper icon and allows you to click anywhere on the map to 

select the color at that place on the map and assign it as the brush 

color. 
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Creating Wind Roses 

A wind rose is a set of lines radiating from a point on a map. Wind roses were used long ago by 

cartographers and navigators to indicate directions to sail to get from one place to another 

(usually from city to city). Realm Studio allows you to create, style, and place wind roses on your 

map. 

You can change the color and style of your wind roses using the controls in the Wind Rose box. 

Place wind roses by clicking the Windrose button, then clicking anywhere on your map. Each 

time you click on the map, a wind rose will be placed, centered at the location where you clicked. 

Click the Windrose button again to stop placing wind roses. You can remove all the wind roses 

you’ve placed by clicking the Remove button. 

Future versions of Realm Studio may add more options for styling wind roses. 
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The Land Tab 

Painting Landforms 

 

To create landforms on a Realm Studio map, you “paint” them like 

colors are painted onto the ocean layer. 

To paint a landform, click the Paint button with the paintbrush icon. 

Like when painting color on the ocean, the cursor will change to a 

dotted-line circle with crosshairs at the center. The circle area is the 

area that will be painted. Holding the left mouse button down and 

dragging the circle will paint the landform. As you paint the 

landform, Realm Studio fills the landform area with the selected 

background texture, paints the coastline with the selected style and 

size, and paints a gradient around the borders of the landform. It also 

(by default) calculates the contour (border) of the landform. 

You can paint each landform you create with a different background 

texture, border color, coastline color and style, and coastline effect 

distance. This is one difference between Realm Studio and 

Wonderdraft. In Wonderdraft, all landforms have the same style and 

colors, and changing the style or colors changes all landforms that 

have been painted. In Realm Studio, all landforms are independent 

objects with their own style and colors. 

You can also erase landforms by clicking the Erase button (with the 

eraser icon). 

Landform Brush Size 

You can change the size of the landform brush by using the Brush 

Size trackbar slider or by rolling the mouse wheel forward or 

backward when the Drawing Mode is set to Landform Paint. 

Landform Outline Color 

Clicking the Color Palette button under the Brush Size trackbar 

allows you to select a color for the landform outline. Clicking the 

button will display a Color Selection dialog. Select the color you want 

to use for the landform outline. Changing the landform outline color 

also changes the color of the shading around the outer edges of the 

landform (just inside the outline). 
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Outline Width 

You can change the width of the outline of the landform using the Outline Width slider. 

Background Color 

If you don’t want your landform filled with a texture, you can select a color for the landform 

by clicking the Background Color button. To fill the landform with the selected color, the 

Texture Fill button must be unchecked. 

Landform Texture 

You can change the texture used as the background of landforms. Scroll through the textures 

using the buttons at the bottom left and bottom right of the texture preview to find the one 

you want to use. The texture that is displayed in the texture preview will be used as the 

background texture of the landforms you paint. 

If you don’t want the landform you paint to be filled with a texture, uncheck the Texture Fill 

checkbox. If the checkbox is not checked, the landform will be painted with the color selected 

using the Background Color button. 

Coastline Effect Distance 

Realm Studio paints a coastline effect (or you might think of it as a shallow water effect) 

around the landforms you paint. The Coastline Effect Distance trackbar changes how wide 

the coastline effect is. Setting the Coastline Effect Distance to zero will result in no coastline 

effect being painted. The slider also governs how wide the shaded area around the outer edge 

of the landform is, so setting it to zero also causes no shading to be painted. 

Coastline Color 

You can change the color of the coastline effect by clicking Color Palette button in the 

Coastline box and selecting a color in the Color Selection dialog that is displayed. As for the 

other Color Palette buttons, the color you select is shown as the background color of the 

Color Palette button, so you always know what color is selected. 
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Coastline Style 

There are several different patterns that can be selected from the Style list to paint the 

coastline effect. If you select “None” in the list, then no coastline effect is painted, but the 

shading gradient around the outer edge of the landform will still be painted. The picture below 

shows an example of each of the patterns. 

 

Merging Landforms 

When you are painting your landforms, if the area you paint overlaps with another landform 

that you previously painted, Realm Studio “merges” the landforms when you release the mouse 

button; that is, the two landforms are merged into a single landform. The merged landform 

takes on the characteristics of the previous landform that was painted. You don’t have to take 

any action to merge overlapping landforms; Realm Studio merges them automatically. 

Erasing Landforms 

You can erase landforms (or parts of a landform) by clicking the Erase button (with the eraser 

icon). As for painting landforms, the cursor changes to a dashed circle with crosshairs. Hold 

down the left mouse button and drag it to erase. The size of the eraser can be changed by using 

the Eraser Size trackbar slider. A useful technique for creating landforms is to paint the rough 

shape you want for the landform, then “sculpt” the landform by using a small eraser to make 

more detailed changes to the shape, 
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Changing Landform Attributes 

Clicking the Select button (with the arrow icon) will change the Drawing Mode to Landform 

Select. When in this mode, clicking on a landform will select it. The selected landform will have 

a dashed box drawn around it. When a landform is selected, you can make changes to it or 

delete it entirely. When the Drawing Mode is Landform Select, right-clicking on the landform 

will open a dialog showing the current data for the landform. The dialog looks like this: 

 

In the dialog, you can give the landform a name and change the look of the landform. Clicking 

the Apply button will apply the changes to the selected landform (and only the selected 

landform). Clicking the button next to the Name textbox will use the Realm Studio Name 

Generator (see the previous section) to generate a random name for the landform. If you like the 

name you’ve entered or that was generated, you can click the Lock button to prevent 

accidentally generating a new name that replaces the existing name. 
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In the title bar of the Landform Info dialog, the Edit Landform Description button  allows 

you to open an AI-assisted Description Editor dialog to enter a description for the landform. See 

the section below on the Description Editor. 

Filling the Entire Map Area with a Landform 

Clicking on the Fill button (with the fill icon) will fill the entire map with a single landform. 

Before filling the map, Realm Studio verifies that no landforms have been painted. It will 

prompt you to clear the existing landforms, if any have already been painted. 

Once the map has been filled, you can sculpt the edges of the using the landform Eraser to 

create coastlines. 

Clearing Landforms 

Clicking the Clear button (with the empty square icon) will clear all painted landforms from the 

map. Before clearing the landforms, Realm Studio prompts you for confirmation. 

Generating Random Landforms 

Realm Studio includes functionality to generate random landforms of various kinds. Clicking 

the Type dropdown under the Generate button allows you to select what kind of landform(s) you 

want to generate. Clicking the Generate button will then generate a random landform of that 

type. The generated landform(s) will have the border color, background texture, coastline effect 

width, color, and style currently selected. 

Realm Studio can generate the following types of landforms: 

• Region: a Region is a large area of a world not necessarily surrounded by water. 

• Continent: a Continent is a large area surrounded by water, that often has one or more 

islands nearby. 

• Island: an Island is a relatively small landform surrounded by water. 

• Archipelago: an Archipelago is a group of islands relatively near one another. 

• Atoll: an Atoll is a ring-shaped group of low islands, usually found in tropical regions. 

• World: a World usually contains many landforms of different types and may have polar 

icecaps or continents. 

Using the Random Landform Generation Function 

The Landform Generation function uses simplex noise and a randomly selected “shaping 

function” (a bitmap found in the Assets/Shaping Functions folder) of the chosen type to generate 

random landform shapes. Once the shape of the landform is generated, Realm Studio calculates 

the boundary of the landform and then applies shading and textures to create the landform as it 

appears on the map. When generating continents, archipelagos, and entire world maps that 

may include many individual landforms, the calculations can take up to several minutes. Realm 

Studio displays a progress bar when generating world maps so you can track the progress of the 

landform generation. 

https://en.wikipedia.org/wiki/Simplex_noise
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Occasionally, the randomly generated landform shape will be such that the boundary 

calculation fails. When that happens, the boundary may be displayed as a long straight line or 

will not completely enclose the entire landform. If that happens, you can either clear all the 

landforms and re-generate, select the landform with the incorrect boundary and delete it, or 

attempt to fix the boundary by erasing the part of the landform that has a boundary and let 

Relam Studio re-calculate the boundary. Attempting to fix the landform using the Eraser may 

not work, so you may have to delete the generated landform and try again. 

If you click the Area button (under the Generate button), you can select an area of the map by 

clicking and holding the left mouse button and dragging the mouse. The selected area will be 

surrounded by a green dotted-line box. If you then select a landform type (continent, island, 

archipelago, or atoll) and click Generate, Realm Studio will generate a landform of the selected 

type within the selected area. By using the Area button to select areas to fill with generated 

landforms, you can quickly create an entire world, but with more control over the results than 

randomly generating a world using the World type. 

When you select the World type, Realm Studio will fill the entire map area (any area selected is 

ignored) with a random number of generated landforms placed randomly on the map. Northern 

and southern polar icecaps/continents may also be generated (you will have to paint them to 

make them look like ice; initially, they are generated looking like the other generated 

landforms). 

Once random landforms of any type are generated, they can be modified like landforms you 

create by painting. 

Future versions of Realm Studio will expand on landform generation functionality and include 

automatic generation of cities and other map features. 
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Painting on Landforms 

  

Just as for the Ocean layer, you can paint and shade colors on top of 

landforms. Painting on landforms works the same as it does on the 

Ocean layer. 

Select a Color Brush, then click the Color icon to change the 

Drawing Mode to Landform Color. The cursor will turn into the 

usual dashed circle with crosshairs. Paint color on top of your 

landforms by holding down the left mouse button and dragging. You 

can change the brush size and brush velocity using the sliders.  

Brush velocity controls how often color is painted as you move the 

mouse. This allows you to control the density of the color that is 

painted, allowing colors to be blended. Reducing the opacity of 

painted colors (making them more transparent) allows color to be 

blended more effectively also, often giving a better appearance.  

Erase color that you have painted by clicking the Erase button. 

Change the painted color by clicking the Color Palette button and 

selecting a color from the Color Selection dialog. 

You can also select a preset color by clicking one of the color presets. 

There are six default preset colors. As on the Ocean layer, you can 

create your own preset colors by clicking the “+” button on the right 

side of the main menu bar. 

You can clear a preset color you have selected and holding the ctrl 

key and clicking the preset button. You can only clear preset buttons 

that you have defined; the default presets cannot be changed or 

cleared. 

Clicking the eyedropper button changes the cursor to an eyedropper 

and lets you click anywhere on your map use the color at that 

location as the selected color for painting. 

Colors painted on landforms are clipped to the outer boundary of the 

landform; that is, you cannot paint landform colors outside of the 

landforms. There is a setting on the Preferences dialog to disable 

clipping of painted colors. 
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The Water Tab 

Painting Water Features 

 

 

 

 

 

 

 

 

 

 

Realm Studio allows you to paint water features (lakes, 

rivers, and so on) on top of the landforms that you paint. 

Clicking the Paint button (with the paintbrush icon) changes 

the Drawing Mode to Water Feature Paint. When in this 

mode, the cursor changes to the usual dotted-line circle with 

crosshairs. Holding down the left mouse button and dragging 

the mouse paints a water feature on top of a landform. 

Water features are clipped to the boundaries of the landform, 

so you can’t paint a water feature on top of ocean or 

background areas of your map. 

Water features are painted with the selected Water Color 

and are shaded with a gradient derived from the color. The 

shoreline of the water feature is painted with the Shoreline 

Color and is shaded with a gradient derived from the 

Shoreline Color. You can change the Water Color and the 

Shoreline Color in the usual way by clicking on the Color 

Palette button. 

Like with landforms, overlapping water features that you 

paint are merged into a single water feature (except for 

Rivers). 

You can select a water feature by clicking the Select button, 

then clicking on the water feature. When selected, you can 

change or delete the water feature like you can with 

landforms. Right-clicking will open a dialog allowing you to 

give the water feature a name or change its colors. 



November 22, 2024 

 

P a g e  41 | 84 

Erasing Water Features 

Clicking the Erase button with the eraser icon changes the Drawing Mode to Water Feature 

Erase. When in this mode, the cursor changes to the usual dotted-line circle. Holding the left 

mouse button down and dragging it will erase painted water features and lakes. The Eraser 

Size trackbar slider adjusts the size of the eraser. As with landforms, the eraser can be used to 

sculpt painted water features that have already been painted to give them the detailed shape 

that you would like. 

Painting on the Water Layer 

 

As with the ocean layer and landforms, you can paint on top of water 

features. The controls for painting on top of water features work the 

same way as they do for the ocean layer and for landforms. 

Select the brush you would like to use (the gradient “soft” brush or the 

“hard” brush). Click the Color button with the paintbrush icon to set 

the Drawing Mode to Water Feature Color. Use the dotted-circle 

cursor to paint on top of water features (painted water features, lakes, 

or rivers). You can use painted color on top of water features to blend 

rivers with lakes and painted water features, to indicate areas of fast-

flowing water, create swampy areas, and so on. 

Like for landforms, color painted on water features is clipped to the 

boundaries of water features you have created, so you cannot paint 

water feature colors on top of landforms, ocean, or the map background. 

You can erase color that you have painted on top of water features by 

clicking the Erase button. 

You can make use of color presets and set your own preset colors in the 

same way as you do for ocean colors and landform colors. 

 

Use the “+” button to choose a preset color and assign it to a button. 

Use the eyedropper to pick a color anywhere on the map to assign it as 

the paint color. 
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Creating Lakes 

A lake can be generated with a random shape by clicking the Lake button, then clicking on a 

landform at the location you want a lake. Lakes are water features, like those that you paint, so 

overlapping lakes are merged into a single lake, and lakes that overlap water features that you 

paint (or have already painted) are merged with the painted water feature. The water brush 

size indicates the size of the lake that is generated (the boundaries of the cursor circle are 

roughly the boundaries of the generated lake). 

Creating Rivers 

In Realm Studio, rivers can be painted by clicking the River button, which changes the Drawing 

Mode to River Paint. Rivers are water features; however, rivers do not merge with painted 

water features or lakes. You paint a river by clicking at the location of the source of the river, 

then holding down the left mouse button and dragging the cursor to the end point (mouth) of the 

river. As you are dragging, you can move the mouse to paint curves in the river. 

You can taper the river from source to end by enabling the Source Fade-In switch (it is enabled 

by default). When the switch is enabled, the source of the river will start as a point, then 

gradually widen to the value set by the width trackbar slider, simulating how most rivers start 

as small streams, then gradually widen as more streams and rivers join. If you don’t want your 

river to taper, disable the switch. Your river will be painted with the width set by the trackbar 

slider for its whole length. 

By default, rivers are painted with a texture to simulate waves and ripples on a flowing river. 

You can disable the texture by disabling the Texture switch. The effect of applying the texture is 

subtle and might be difficult to see, especially against a textured landform background. 

Rivers are painted with water color gradient shading and shoreline gradient shading. You can 

change the colors of the shading in the same way as for painted water features and lakes. 

When a river is selected, (by clicking the Select button, changing the Drawing Mode to Select 

Water Feature, then clicking on a river) enabling the Edit River Points switch will change the 

Drawing Mode to Edit River and display control points along the path of the selected river. 

Putting the mouse over a control point will highlight it. When a control point is highlighted, you 

can click and drag it to a new position, changing the shape of the river. 
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The Paths Tab 

Drawing Paths 

The controls on the Paths tab allow you to draw paths and walls (roads, trails, footprints, 

animal tracks, city and castle walls, and so on) on top of landforms. There are several different 

styles of paths that can be drawn, from simple lines to paths drawn with a border and filled 

with a texture. The are two styles of walls, differing only in whether the towers in the wall are 

round or square. Paths and walls can be drawn under symbols that are placed on the map (this 

is the default), or they may be drawn on top of placed symbols, if you need to achieve a 

particular effect on the map.  

  

Walls with towers are created in the same way as Texture Filled or Border and Texture paths. 

Choose the texture for the wall from the Texture Preview. The look of the wall is often improved 

by scaling the texture down. The Tower Distance and Tower Size controls change the spacing of 

towers along the wall and their size. The values are relative to the width of the wall so that they 

remain proportional. A tower is always drawn at the start of the wall, and then drawn spaced 

along the wall based on the Tower Distance value. 

If you hold down the shift key while drawing a path, you can draw a straight-line path. The 

angle of the path is limited to 5º increments (0º, 5º, 10º, 15º…355º). Holding down the ctrl key 

To create a path or wall, select the style you 

want from the set of styles on the right side 

of the Realm Studio main window (the path 

controls and the path styles are displayed 

when you click on the Path tab). 

Select the width of the path or wall and the 

color using the trackbar and the Color 

Palette button. Use the Draw Over Symbols 

switch to set whether the path or wall will 

be drawn on top of placed symbols or under 

them. 

Click the Draw button to begin drawing 

paths. Hold down the left mouse button and 

drag the mouse to draw the path or wall. 

For Texture Filled and Border and Texture 

path styles, select the texture from the 

Texture preview. You can change the scale 

and opacity of the texture using the sliders 

to get the look you want for the path. 
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will draw a straight-line path that is either horizontal or vertical. The direction of the straight-

line path is determined by the direction you drag the mouse cursor. 

Editing Paths 

After you have drawn a path, you can delete it, move it, or edit individual points on the path. 

Click the Select button to change the Drawing Mode to Select Path, then click on a path to 

select it. A box will be drawn around the selected path. When selected, you can delete the path 

by pressing the Delete button. You can also move the path by holding down the left mouse 

button and dragging it to a new location. 

If the path you have drawn is not quite the right shape, you can display control points along the 

path by selecting it and then enabling the Edit Path Points switch. Doing so will display control 

points as small white circles. Moving the mouse cursor over a point will highlight it in purple. 

You can click and drag a control point to a new location, changing the shape of the path. 

Pressing the Delete button will delete a highlighted control point. 
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The Symbols Tab 
The Symbols tab controls allow you to place symbols from your Symbol Collections on your map. 

  

The Scale trackbar slider and up/down control allow to 

scale (resize) symbols. The lock icon allows you to lock the 

scale, so all symbols you place have the same scale. 

The Color Palette buttons allow you to choose three colors 

with which to paint the symbols you place. Checking the 

Randomize button will cause painted symbols to have 

slightly different colors than the selected color, giving 

groups of symbols (like a forest of trees) a little more 

interesting look. There is more on painting symbols below. 

The controls in the Placement box allow you to enable the 

Area Brush (a dotted circle cursor) and set its size so that 

large areas of the map can be filled or painted quickly. 

The Mirror Symbol switch causes the symbol to be flipped 

horizontally. The Rotation trackbar slider and up/down 

control rotate the symbol around its center. The Rate and 

Density up/down controls change how often symbols are 

placed and how close together they are placed. 

The symbols you can choose from to place on your map 

are displayed in the Symbol List on the right of your map. 

The Collections list shows all the Symbol Collections from 

which you can select symbols to place on your map. By 

clicking the checkboxes, you can filter the symbols 

displayed to just those from the selected collections. 

The Tags list shows all the tags available for tagging 

symbols. The checkboxes next to the tags filter the 

symbols to just those with the selected tags. 

The buttons below the divider display all the symbols of 

the associated Symbol Type (Structure, Vegetation, 

Terrain, Marker, and Other), select the first displayed 

symbol of that type, and let you start placing symbols. 

The symbols displayed are filtered by any collections or 

tags you have selected. You must select a Symbol Type to 

display and place symbols. 
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On the right of your map, the filtered Symbol List is displayed. If 

you haven’t selected any Symbol Collections from the Collections 

list or tags from Tags list, all the symbols for the Symbol Type 

(Structure, Vegetation, Terrain, Marker, or Other) you click are 

displayed (from the Symbol Collections you have available). 

Click a symbol to select it and place it on your map. When you 

select a symbol, it is highlighted in blue, and the mouse cursor 

changes to an image of the symbol. This is the Primary Selected 

symbol. You can change the size of the symbol by rolling the mouse 

wheel forward and back or by using the Scale trackbar slider. Place 

the cursor on your map by clicking where you want to put it. If the 

scale is locked, you cannot change the size of the symbol. 

Holding the mouse button down and moving the mouse will place 

copies of the symbol as you move it. How close together and how 

often symbols are placed can be changed using the Rate and 

Density up/down controls. 

When creating forests, mountain ranges, villages, or whatever, you 

may want to place many related symbols near each other. Realm 

Studio allows you to do this easily. First select a symbol by clicking 

on it. Then, hold down the shift key and click on the related 

symbols you want to place. They will be highlighted in a lighter 

shade of blue. The light blue selected symbols are the “Secondary 

Selected” symbols. Hold down the left mouse button and move the 

mouse over your map where you want to place symbols. Realm 

Studio will randomly choose one of the symbols you’ve selected and 

place it each time it places a symbol. To clear the list of selected 

symbols, just click on another symbol. 

You can use the Area Brush switch to enable the Area Brush when 

painting Vegetation or Terrain symbols. When the Area Brush is 

enabled, the dotted-line circle cursor is displayed. As you hold the 

left mouse button and move the mouse, symbols are painted within 

the area of the circle cursor. This works best with small symbols to 

fill large areas (like forests). You can also use the Area Brush to 

paint large areas filled with grayscale symbols with a color. The 

Area Brush also works with Secondary Selected symbols. 

You can search for a symbol (or symbols) by typing in the Search 

box above the Symbol List. You must type at least three characters 

to filter the list. 
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Selecting Symbols 

To select a symbol that has been placed on your map, click the Select button (with the arrow 

icon). The Drawing Mode will change to Select Symbol. Click on the symbol to select it. Realm 

Studio draws a green dashed box around a selected symbol 

Displaying Symbol Information 

Realm Studio will display information about symbols in two ways. 

First, if you right-click on a symbol in the Symbol List, a dialog box will be shown with some 

information about the symbol. 

  

You can change the tags for the symbol by selecting them in the Symbol Tags box, then clicking 

the Apply Tags button. You can also add new tags to the list of available tags by entering a tag 

in the text box below the Symbol Tags list, then clicking the Tag icon button next to it. 

You can also change the Type of the symbol (but this should almost never be necessary). 

Second, you can display information about a symbol that has been placed on the map. To do so, 

click the Select button, then right-click the symbol on your map. A dialog with information 

about the selected symbol will be shown: 

<path to symbol file> 
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This dialog allows you to name the symbol (for example, if the symbol indicates the location of a 

tavern, you can put the name of the tavern in the Name field). You can also change the tags for 

the selected symbol, create a new tag (as described above), and if the symbol is grayscale or 

paintable with custom colors, paint the symbol with the selected color(s). To paint the symbol, 

select colors with Color Palette button, and then click the Paintbrush button. 

Erasing Symbols 

To erase symbols that have been placed on your map, click the Erase button (with the eraser 

icon). Like other erasing functions, the cursor will change to the dotted-line circle cursor. Hold 

down the left mouse button and move the mouse over your map. All symbols within the circle 

cursor will be removed from the map. You can also delete a symbol by selecting it and pressing 

the Delete key on your keyboard. 

Moving Symbols 

You can move a symbol that has been placed on the map by selecting it, then holding down the 

left mouse button and moving the mouse to move the symbol to a new location. The symbol will 

move along with the mouse cursor. Release the left mouse button to place the symbol. You can 

also move a selected symbol using the right/left/up/down arrow keys on your keyboard. 

<path to symbol file> 
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Painting Symbols 

Grayscale symbols placed on your map can be painted with a single color. The color of symbols 

paintable with custom colors can also be changed, but in a different way, using the three colors 

from the Symbol Tab Color Palette buttons. 

Grayscale symbols can be painted individually or using the Area Brush; however, only 

Vegetation and Terrain grayscale symbols can be painted with the Area Brush. Structure and 

Other symbols cannot be painted with the area brush. 

To paint a grayscale symbol, select it, then either right-click one of the three Color Palette 

buttons on the Symbol tab, or select it and click the Paint button (with the paintbrush icon). 

Right-clicking one of the three Color Palette buttons will paint the grayscale symbol with the 

color of the right-clicked button. Clicking the Paint button will paint the selected symbol with 

the color of the first (leftmost) Color Palette button. You can also paint grayscale symbols 

quickly by selecting the Symbol Type button corresponding to the symbols that you want to 

paint, selecting the color you want to paint the symbols in the first Color Palette button, then 

clicking and holding the left mouse button and dragging the crosshairs cursor over the symbols. 

Just above the Color Palette buttons is a checkbox labeled “Randomize.” By checking this 

checkbox, when you paint symbols with the crosshair cursor or with the area brush, the color 

that is painted onto the symbols will vary by 10% from the selected color. This gives features 

like forests and rows of houses some variation in color, improving their appearance. Future 

versions of Realm Studio will improve this feature. 

Symbols that are paintable with custom colors start out looking like this: 

 

As you can see, colorable symbols are painted black, white, green, blue, and red. This is how 

paintable symbols will appear on the Add/Update Symbol Collection dialog when you create the 

symbol collection. In the Symbol List and when the symbol is placed on your map, the red, blue, 

and green colors are replaced by the three colors shown on the three Symbol tab Color Palette 

buttons, so it will look something like this: 
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Red is mapped to (replaced by) the color of the first (leftmost) Color Palette button. Green is 

mapped to the second (middle) Color Palette button. Blue is mapped to the third (rightmost) 

Color Palette button. 

You can change the colors of a custom colorable symbol either by selecting it and changing the 

colors on the Color Palette buttons or by selecting and right clicking the symbol to open the 

Symbol Info dialog for the symbol and changing the colors on the Color Palette buttons in the 

Symbol Info dialog. When you change the symbol colors from the Symbol Info dialog, the colors 

of the symbol are changed when you close the dialog. 

Changing the Rendering Order of Symbols 

When you place symbols on your map, they sometimes overlap, so a symbol is “in front” of 

another symbol. Often, you want the symbols to overlap, but you want the symbol currently in 

front of another symbol to be behind it. 

Here is an example: 

 

In this case, you might want the tall green tree to appear as if it is behind the ruined building. 

By selecting the tree and pressing the Page Up and Page Down keys on your keyboard, you can 

change the order that the symbols are rendered (drawn by Realm Studio), making it appear that 

the tree is behind the ruined building (or you can select the building and change its position). 

 

Symbols that are rendered later will appear to be in front of symbols that are rendered earlier. 

The Page Up key moves the selected symbol one position later in the rendering order; the Page 
Down key moves it one position earlier. Holding down the ctrl key while pressing Page Up or 

Page Down moves the symbol five positions later or earlier. If you have a lot of symbols on your 

map (like, for example, with a forest), it can be tedious to get the symbol positioned in the right 

place in the rendering order. To help with that, you can press the Home and End keys while a 

symbol is selected. Pressing the Home key moves the symbol to the top of the rendering order 
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(behind all other symbols). Pressing the End key moves the symbol to the bottom of the 

rendering order (in front of all other symbols).  

Future versions of Realm Studio will enhance the controls for setting the symbol rendering 

order. 
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Labels Tab 
The controls on the Labels tab allow you to place labels and boxes on your map. 

 

Label Presets allow you to quickly set the font, font size, 

outline, and glow for your label. 

Clicking the “+” button allows you to create a named 

preset from the currently selected font, font size, outline, 

and glow from the current settings. Clicking the “-” button 

allows you to delete a Label Preset. The pre-defined 

default Label Presets cannot be deleted. 

Clicking the Select Font button opens the Font Selection 

panel. Select a font and font size from the drop-down lists 

and the select font style (bold or italic) using the buttons. 

Clicking the large “A” button increases the font size. 

Clicking the small “A” button decreases the font size. 

Click the OK button to set the label font. The label of the 

Select Font button changes to use the font you selected for 

the text of the button label. 

Use the Font box Color Palette button to select the color of 

the label text. 

Use the Outline box Color Palette button to select the 

color of the outline around your label text. Use the 

trackbar slider to set the outline width. 

Use the Glow box Color Palette button to select the color 

the “glow” around your label. Use the Strength trackbar 

slider to set the area of the glow and its opacity. 

Experiment with this to get the appearance you want, as 

it can be difficult to see the glow against some 

backgrounds. 

The Rotation trackbar slider and up/down control are 

used to rotate a selected label. 

A label can follow an arc or curve you draw. Clicking the 

Arc and Curve buttons sets the Drawing Mode so that 

you can draw an arc or curve for a label to follow. 
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Creating a Label 

To create a label, click the Label button (with the I-beam icon). The Drawing Mode is set to 

Place Label. Click on the map where you want to place your label. (First, be sure to set the 

label font, size, outline, and glow). A text box will be placed on your map where you clicked, with 

the prompt “…Label…” in it. Type the text of your label in the text box (what you type will 

replace the prompt), then press the Enter key. The text box will be replaced with your label, 

and the label will have the style (font, size, etc.) that you selected. The label will be selected 

(have a dotted line box) drawn around it. When the label is selected, you can move it by 

dragging it with the mouse to get it to the exact position you want. 

Selecting a Label 

To select a label, click the Select button (with the arrow icon) on the Label tab. The Drawing 

Mode will change to Select Label. Click on the label. The selected label will have a dotted line 

box drawn around it. 

Changing the Appearance of a Label 

You can change the appearance of a label that has been placed on the map. To do so, select the 

label, then use the controls (as shown above) to change the font, font size, color, outline, and/or 

glow styles. The appearance of the label will change to reflect the styles you choose. 

Deleting a Label 

To delete a label, select it then press the Delete key on your keyboard. 

Rotating a Label 

You can rotate a label around its center by selecting the label, then using the Rotation trackbar 

or the Rotation up/down control to rotate it. The label can be rotated from 0º to 359º in 1º 

increments. The label will rotate as you move the slider or change the rotation value in the 

up/down control. 

Creating a Label that Follows an Arc 

To create a label that follows an arc, you must first draw the arc that the label will follow. Click 

the Arc button at the bottom of the Label tab. The Drawing Mode changes to Draw Arc Label 

Path. Move the cursor to approximately where you want the label to be placed, then click and 

hold the left mouse button down while moving it to the right and down. You can also move the 

mouse to the right and up to create an arc that curves up. An arc will be drawn with a dotted 

line as you move the mouse. Release the left mouse button when the arc is the size and 

curvature that you want. 

Next, click the Label button (with the I-beam icon) and create a label as described above. The 

label will be created when you press the Enter key, but rather than being placed wherever the 

label text box was placed, the label will follow the arc that you drew, like this: 
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Just as when a “normal” label is created, the label following an arc is initially selected and can 

be moved, rotated, deleted, or have its font and style changed. 

A label that is placed on an arc that curves tightly will probably not look very good, so keep that 

in mind when creating curved labels. 

Creating a Label that Follows a Freeform Curve 

Clicking the Curve button allows you to draw a freeform curve that your label will follow. The 

process is the same as when creating labels that follow an arc: Click the Curve button. The 

Drawing Mode will change to Draw Curve Label Path. Draw the curve by holding down the 

left mouse button and moving the mouse. Release the mouse button when you are done drawing 

the curve. If you don’t like the curve you’ve drawn, press the Escape key. Pressing the Escape 

key cancels all pending operations. Once you have a curve you like, proceed to create the label 

as described above. Just as when creating a label that follows an arc, when you press the Enter 

key in the label text box, the label will be created following the curve you drew, like this 

example. 

 

For both labels that follow arcs and labels that follow freeform curves, when the label is created, 

it is left-justified on the arc or curve. It can take some practice to create an arc or curve that fits 

the size and shape of the label you want to create. Like for arcs, tight curves will probably not 

look very good, especially for larger fonts. 
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Creating Box Frames 

 

Realm Studio allows you to place boxes of various styles onto 

your map as frames around labels. There are several styles of 

boxes that you can choose from, and additional styles can be 

downloaded from Cartography Assets. Boxes that are usable with 

Wonderdraft can be used with Realm Studio. Like for other types 

of assets, Wonderdraft box assets must be imported into Realm 

Studio before they can be used. When the box asset is imported 

into Realm Studio using the Import Wonderdraft Assets dialog 

(as discussed above), an XML file is created that describes the 

box asset to Realm Studio. Once the XML file is created, the box 

asset can be loaded by Realm Studio. 

To create a box frame on your map, select the box style that you 

want to use from the list on the right of your map. It will be 

highlighted in blue. Click the Box button (with the square icon), 

then hold down the left mouse button and move the mouse down 

and right to draw the box. Release the mouse button when the 

box is the size and shape you want. 

Boxes can be “tinted;” that is, their background color can be 

combined with a selected color. You can select the tint color by 

clicking the Color Palette button above the list of box styles and 

selecting a color from the color selection dialog. You can change 

the tint of a box that has already been placed by selecting it, then 

clicking the “Select Tint Color” Color Palette button and choosing 

a color from the dialog. 

A box that has been placed can be moved by selecting it, then 

holding down the left mouse button and moving the mouse. The 

selected box will follow the mouse cursor as it moves. 

A box that has been placed can be deleted by selecting it and 

pressing the Delete key on your keyboard. You can undo the 

deletion by selecting the Undo menu item from the Edit menu or 

by pressing ctrl+z on your keyboard. 

Labels on your map will be drawn in front of any boxes that are 

placed, so boxes can be used (and are intended to be used) as 

frames around labels to create titles, legends, etc. for your maps. 

Simply drag any labels you want to position them over the box 

that will act as the frame for the labels. 
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Overlays Tab 
The Overlays tab includes controls for creating frames around your map, placing grids (square 

and hexagonal), generating a scale for your map, and for measuring distance and area. 

 

Map Frames 

At the top of the tab in the Frame box, the Enable switch 

enables and disables rendering of the frame surrounding your 

map. The Frame Tint Color Palette button allows you to apply a 

tint to the frame you select (in the same way that boxes are 

tinted). The Scale trackbar changes the size (width) of the 

frame. The frame will always surround your map, even as it is 

scaled larger or smaller. You select the style of the frame you 

want to place on your map from the list of frame styles in the 

panel to the right of your map. 

Grids 

In the Grid box, you can enable/disable and change the type, 

size, and color of a grid placed on your map. The Layer up/down 

control allows you to select where your grid will be rendered 

relative to other objects drawn or your map. By default, the grid 

will appear under boxes, labels, and the map frame, but over 

everything else. However, the grid can be placed so that it 

appears over the background and ocean layers, but under 

everything else, or above landforms and water features, but 

under symbols, paths, boxes, labels, and the frame. When the 

Show Grid Size switch is enabled, Realm Studio will print text 

in the lower-left corner of your map indicating the size of each 

square or hexagon in the grid using the map area units. To 

place the grid on your map, click the Grid button. You can 

change the frame style after it has been placed on your map. 

Measuring Distance and Area 

You measure distance in your map using the Measure function. 

To measure distance, click the Measure button., then click the 

left mouse button where you want to start measuring and move 

the mouse to the end of where you want to measure. A line will 

be drawn in the color of the Measure Color Palette button. At 

the endpoint of the line, text is drawn indicating the length of 

the line. If the Use Scale Button switch is enabled, distance will 

be given in map area units (e.g. miles). 
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You can continue measuring by clicking the left button again and 

moving the mouse. The cumulative length of the lines is drawn at 

the end of lines. Right click the mouse to stop measuring. 

You can also measure approximate area using the Measure function. 

First, enable the Measure Area switch. After enabling the Measure 

Area switch, the process is the same as for measuring distance, 

except as you move the mouse, an area will be highlighted, and text 

will be drawn giving area rather than distance. You must have set 

at least two points before area will be displayed. 

Clear the measuring lines or area by clicking the Clear button. 

Choosing a Frame 

When the Overlay tab is selected, a list of frame styles you can 

choose is displayed to the right of your map. To display a frame on 

your map, just select the frame style you like from the list. Once the 

frame is placed, you can change the scale and tint or disable the 

frame using the controls in the Frame box. 

As with symbols and other kinds of assets, more frame styles are 

available for download at Cartography Assets, some free and some 

for purchase. Frames that can be used with Wonderdraft can 

(usually) be used with Realm Studio. Click this link to take you to a 

list of Wonderdraft frames on Cartography Assets that you can 

download for use with Realm Studio. Zip files containing frame 

styles downloaded from Cartography Assets must be imported using 

the Import Wonderdraft Assets dialog described earlier. More 

detailed information on the process for importing assets created for 

Wonderdraft into Realm Studio is provided in the Technical 

Information section at the end of this document. 

https://cartographyassets.com/asset-category/specific-assets/wonderdraft/custom-frames/
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Creating a Map Scale 

Clicking the Scale button displays a panel with controls 

for creating a scale indicating distance on your map. A 

map scale looks something like this: 

 

There are several controls for changing the appearance of 

map scales. The Width and Height trackbar sliders change 

the size of the map scale. The Segments slider changes the 

number of distance segments in the scale. The Line Width 

slider changes the width of the map scale outline. 

The Color Palette buttons change the color of the 

alternating segments and the outline. 

The Segment Distance up/down changes the distance 

labels displayed above the map scale. The text in the Unit 

Label text box is drawn as the label below the map scale. 

The default text for this box comes from the map scale 

units chosen in the Realm Configuration dialog, but you 

can change the label by entering it in the Unit Label text 

box. 

The Number Display radio buttons control where the map 

scale distance segment labels are displayed. 

You can change the font, font color, outline color, and 

outline width of the numbers and unit labels using the 

Select Font button, Font Color Palette, Numbers Outline 

Color Palette button, and Outline Width slider. 

Once you have set the map scale style as you like, click the 

Create Button. A map scale will be created and placed at 

the lower left corner of your map. You may have to pan the 

display of your map using the scroll bars or by holding 

down the middle mouse button and moving the mouse to 

be able to see the map scale. You can move the map scale 

by clicking on it and moving the mouse while holding 

down the left mouse button. The map scale will follow the 

mouse cursor. 

Delete the map scale by clicking the Delete button. 
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Regions Tab 
The controls on the Regions tab allow you to create highlighted and bordered regions on your 

map. A Region could be a geographical region, a country or some other political entity, or 

whatever else you like. Creating Regions is relatively simple, but there are some operations that 

are a bit complex, so there is some text on the Regions tab to help remind you how to do them. 

 

 

To create a Region, set the border color, border width, 

smoothing (how rounded the corners of the region are), and 

how clear or opaque the inner area of the region is. Click the 

Create button (with the flag icon). The Drawing Mode will 

change to Draw Region. Click at a point where you want to 

place the Region. Drag the mouse to the next point in the 

Region and click the left mouse button. Continue clicking and 

dragging to set each point of the region. As you click and 

drag, the region will be drawn on the map with the style you 

selected. Right click to end drawing the region. 

You can snap a Region to the coastline of a landform. This 

operation can take a little bit a time to learn how to do. The 

process is described in the text on the Regions tab. Unlike 

Wonderdraft, which requires you to wait for a lengthy 

calculation to complete before you can snap a Region to a 

coastline, Realm Studio lets you do so immediately. Hold 

down the shift key and click on the coastline. When you get 

near to the coastline, a small circle is displayed, indicating 

that the cursor is near enough to the coastline to snap the 

region to the coastline. If you drag up, then hold down the 

shift key and click on the opposite coastline, the border of 

the Region will snap to the west (left) coast of the landform. 

If you shift+click on the coastline, then drag down and 

shift+click on the opposite coastline, the border of the 

region will snap to the east (right) coast. Snapping to the 

north (top) or south (bottom) coast of a landform uses the 

same process, as described in the text on the Regions tab. 

 

Above is an example of two regions snapped to a coastline. 
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Drawing Tab 
Drawing functionality which will allow you to draw shapes and place text anywhere on your 

map is coming in a future release of Realm Studio. 

  

Once a Region has been placed, it can be moved or edited. Click the 

Select button, then click on the Region. Control points on the border 

of the Region will be displayed. You can move the entire Region by 

dragging it with the mouse. You can also move a control point by 

highlighting it (by moving the mouse cursor over it), then dragging 

it. Clicking on the border of the Region creates a new control point 

at that location. 

You select the border style of the Region using the radio buttons on 

the panel to the right of your map. 

Delete a Region by selecting it and pressing the Delete key. 

Right clicking a selected region will open a dialog allowing you give 

the region a name, change the color, smoothing, inner opacity, and 

border style 
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The Description Editor 
Landforms, water features (lakes, etc.), rivers, paths (roads, trails, streets), symbols, and 

regions all allow you to enter a description for them. The Description Editor dialog is opened 

from the button on the title bar of the Info dialog for the map object (landform, water feature, 

region, etc.). The editor is a simple plain text editor, but it also includes AI assistance for 

writing the description of the object. 

The AI Assistant is aware of the kind of map object for which it is generating a description, so if 

you want assistance with a description for a landform, it will generate a description of a 

landform, and if you want assistance with a description for a river, it will generate a description 

of a river. However, you can give the AI hints on what you want in the description, so that the 

generated description is more likely to match what you want. The Description Editor looks like 

this. Note that the title bar text changes depending on the type of object being described. 

 

Clicking the Info button opens the Object Characteristics dialog, shown below. On the Object 

Characteristics dialog, you can select an option to further refine the object type. For example, 

rather than describing a “Landform,” you can tell the AI you want a description of an island or a 

continent. The list of Object Types changes depending on the type of the base map object 

(Landform, Water Feature, River, Symbol, or Region). In addition to the Object Type, you can 

give the AI Assistant more hints to help it in generating a description you like. By typing a 

characteristic in the text box next to the “+” button, then clicking the “+” button or pressing the 

Enter key, the characteristic will be added to the list of Object Characteristics. Clicking the 

Apply button will send the selected Object Type and Characteristics to the Description Editor. 
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When you are satisfied with the object type and characteristics you’ve selected, clicking the 

button with the OpenAI logo will make a request to the AI Assistant to generate a description 

that you can use as inspiration. Here’s an example of what the AI Assistant can generate: 

 



November 22, 2024 

 

P a g e  63 | 84 

Zooming, Panning, and Mouse Functions 
 

Realm Studio generally responds to the mouse in the same way as other Windows 

applications do. 

You select objects by first changing the Drawing Mode to select the object type you want 

to select, placing the mouse cursor over the object and clicking the left mouse button. 

When an object in Realm Studio is selected, a dotted-line box is drawn around it. 

You can “drag” some objects by selecting them, then holding down the left mouse button 

while moving the mouse. 

Some objects, such as landforms, water features, lakes, rivers, symbols, paths, and 

regions will display informational dialogs when you set the Drawing Mode to select the 

object, then click the right mouse button on the object. The dialogs usually allow you to 

change attributes of the selected object (object name, textures, colors, and so on). 

While painting landforms and painting color on ocean, landforms, and water features, 

and some other operations, you can quickly change the size of the dotted-circle cursor by 

rolling the mouse wheel forward and backward (up and down). 

You can zoom the map using the controls at the bottom right of the application window: 

 

The trackbar zooms the map. The button with cross arrows zooms the map so that the 

entire map fits into the map display. The button with circular curved arrows resets the 

zoom level to 100% (the default). 

You can also zoom the map by holding down the ctrl key and rolling the mouse wheel 

forward and backward (up and down). 

You can pan the map back and forth and up and down using the scrollbars or by holding 

down the middle mouse button (which is usually the mouse wheel) and dragging the 

mouse. 

Pressing the escape or esc key resets the Drawing Mode to None and cancels any 

pending operation. 
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Realm Studio Assets and Symbol Collections 
 

Creating a Symbol Collection 
As mentioned above, symbols are small images (usually .png files or .svg files) of various 

types of objects that can be placed on your map as representations of those objects – mountains, 

hills, houses, taverns, trees, rocks, banners, mermaids, clouds, and many, many others. 

You can create your own symbols and include them in Symbol Collections if you like, but most 

map makers use collections of symbols created by artists. Websites like Cartography Assets 

(https://cartographyassets.com/) have packs (usually zip files) of many kinds of assets (symbols 

and others) that can be downloaded, both for free and for sale. Realm Studio can import and use 

assets created for Wonderdraft (https://www.wonderdraft.net/). More information on 

downloading and importing symbols created for Wonderdraft is below. Unlike Wonderdraft, 

Realm Studio can also use vector files in the Scalable Vector Graphics (.svg) format as symbols. 

The SVG Repo site (https://www.svgrepo.com ) has thousands of SVG files that you can 

download and use in Realm Studio Symbol Collections that you create. Unlike symbols in other 

image formats, symbols created from SVG files do not become pixelated (blocky) when they are 

resized. 

Future versions of Realm Studio may be able to import symbols created for other mapmaking 

software. 

To use symbols on your map, they must be added to a Symbol Collection. A Realm Studio 

Symbol Collection has two parts: 1) a subfolder for the collection found in your Windows 

Documents folder under the RealmStudio/Assets/Symbols subfolder that contains all the image 

files for the symbols, and 2) a collection.xml file that describes the collection and all the 

symbols in the collection. The collection.xml file is stored in the same folder as the symbol 

images for the Symbol Collection. 

Since you may (probably will) have several thousand different symbols to use when making 

maps, Realm Studio uses Symbol Collections to organize your symbols so that you can find the 

ones you want to use more quickly. In addition, Realm Studio allows you to tag the symbols so 

that all the symbols with selected tags can be quickly retrieved for use on your map. 

Symbol collections originally created for use in Wonderdraft do not have a collection.xml file 

that Realm Studio can read. However, Realm Studio can load the wonderdraft_symbols JSON 

file provided with the Wonderdraft collection. The Add/Update Symbol Collection dialog allows 

you to tag and categorize the symbols in the collection and then create the Realm Studio 

collection.xml file for the collection. The dialog looks like this: 

https://cartographyassets.com/
https://www.wonderdraft.net/
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Creating a Symbol Collection for Realm Studio can be a tedious process, but Realm Studio does 

its best to make it quick and easy. First, it examines the file name and name of the symbol and 

of the collection and applies tags to the symbol based on them. So, if the symbol contains the 

word “house,” for example, it will apply the “house” tag to the symbol. Similarly, Realm Studio 

will try to derive the Symbol Type (Structure, Vegetation, Terrain, or Other) based on the tags 

it applies. There are synonym files in the Assets folder that are used to associate tags with 

symbol types. 

You must select a Symbol Type for each symbol in the collection, but you don’t have to apply any 

tags to the symbols in the collection. However, symbol tags can help you find symbols more 

quickly. For example, if you are creating a village on your map, you might want to gather all the 

symbols of houses to see which ones you want to use. By tagging your symbols, you can easily do 

that by filtering the symbols by tag on the Symbols tab. There is more information on how to 

filter symbols below. 

There are many symbol collections provided when Realm Studio is installed, but not all have 

had a collection.xml file created for them. If you want to use the symbols in the collection, 
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use the process outlined in the next section to categorize and tag the symbols and create the 

collection.xml file. 

IMPORTANT! If you download symbols from Cartography Assets and create Realm Studio 

symbol collections, keep a backup copy of the assets and the collection.xml file. When 

you install a new version of Realm Studio, the assets are also re-installed, and you will need to 

restore the assets and collection.xml files that you have created. In a future version, the 

Realm Studio installer will not overwrite or remove collection.xml files 

Using the Add/Update Symbol Collection Dialog to Create a Symbol Collection 

1. Click the Open button at the top-left of the dialog. This will open a Windows Folder 

Selection dialog. Select the folder under the Windows 

Document/RealmStudio/Assets/Symbols folder that the collection is in. The dialog will 

show the collection path and name in the boxes in the dialog, and the first symbol in the 

collection will be displayed, as shown: 

 

Use the buttons under the image of the symbol to navigate back and forth through the 

set of symbols in the collection. 

<path to collection file> 
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Often, the artist that created the symbol collection will have included preview images or 

other images in the collection that are not symbols to be included in a map. If such an 

image is shown in the preview window, you can click the Remove Symbol button, and 

that image will be excluded from the Realm Studio symbol collection. 

As you can see in the image above, Realm Studio has figured out the symbol type and 

has automatically tagged the symbol. At this point, you can change the name of the 

symbol, change the symbol type, and add or remove symbols tags. You can also add new 

tags to the list of available tags, and the new tags you add will be saved. 

2. If Realm Studio was not able to figure out the symbol type, select a type using the 

Symbol Type radio buttons. 

a. The Structure type is for things that have been made by people: buildings, 

bridges, fences, signs, and so on. 

b. The Vegetation type is for plants of all kinds. 

c. The Terrain type is for mountains, hills, cliffs, ravines – anything that is part of 

the natural landscape that doesn’t grow, 

d. The Marker type is for symbols that indicate locations or points of interest on 

the Realm Map. 

e. The Other type is for miscellaneous symbols that don’t fit into the previous 

categories. 

3. In the Symbol Painting group, you can select if the symbol image is grayscale (black, 

white, and shades of gray) or can be painted with custom colors. 

Grayscale symbols can be painted with a single color using the controls on the Symbols 

tab. 

Symbols that can be painted with custom colors are initially displayed in the 

Add/Update Symbol Collection dialog using red, green, blue, black, and white. When 

they are displayed on the Symbols tab and on your map, the red, green, and blue areas 

of the symbol are replaced by the three custom colors selected on the Symbols tab. There 

is more information on coloring symbols below. 

Very rarely will you have to change what is automatically selected here. Realm Studio 

can almost always figure out which symbols are grayscale and which can be colored. 

4. The tags currently applied to the symbol are shown in the Symbol Tags box. The tags 

that are available to apply to the symbol are shown in the Available Tags box. To add a 

tag to the symbol, click on the tag in the Available Tags box. To remove a tag from the 

symbol, click on the X next to the tag in the Symbol Tags box. When you click the X, a 

small dialog with buttons to confirm or cancel removal of the tag is shown. Clicking the 

green button confirms removal of the tag; clicking the red button cancels removal. 
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5. Once you’ve assigned a Symbol Type and any tags you want to apply to the symbol, click 

the Apply button. Clicking the Apply button commits the changes you’ve made (all the 

values shown on the dialog) to that symbol. If the “Advance on Apply” checkbox is 

checked, the next symbol in the collection will be shown in the dialog. If you click the 

Apply button without assigning a Symbol Type, a warning will be displayed, and the 

dialog will not advance to the next symbol in the collection. 

6. Once all the symbols in the collection have been assigned a Symbol Type, and they have 

been tagged, click the Save button. When the Save button has been clicked, the 

collection.xml file for the Symbol Collection will be created. 

If you open a collection that already has a collection.xml file, Realm Studio will read 

the file to determine the Symbol Type and tags for each symbol. You can then modify the 

Symbol Type and tags, as well as the symbol name, and then save the changes by 

clicking the Save button. 

If you click the Save or Cancel button before all the symbols have been assigned a 

Symbol Type, a warning will be displayed to remind you to assign a type to all the 

symbols in the collection. 
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Importing Assets 

Importing Wonderdraft Assets from a Zip File 

 

Wonderdraft assets downloaded from the Cartography Assets website are packaged as zip files. 

Realm Studio provides a dialog to import the assets from the zip files into your 

Documents/RealmStudio/Assets folder. The dialog is opened from the Assets -> Import 

Assets From -> Wonderdraft Assets Zip File... menu option. It looks like this: 

 

To import assets from a downloaded zip file, follow these steps: 

1. Click the Open button. Realm Studio will display a File Open dialog. Navigate to the 

folder containing the zip file containing the assets (usually they will be in your 

Downloads folder) and click Open in the File Open dialog. The path to the zip file will be 

shown in the box next to the Open button. 

2. Click the Import button. Realm Studio will read and analyze the zip file to find the 

folders in the zip file containing assets of any kind that Realm Studio uses (textures, 

frames, boxes, symbols, and so on). The folders and assets are displayed in a tree 

structure in the box next to the Import button with the folders containing assets 

highlighted with a color indicating the type of asset in the folder: 
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You can select and deselect the assets you want to add to Realm Studio by clicking the 

check box next to the highlighted folders. 

3. Click the Add button. Realm Studio will display a message asking you to confirm that 

you want to copy the assets from the zip file into the Realm Studio Assets directory. 

When you click OK. Realm Studio will copy the assets. When the assets have been 

copied, a message is displayed to let you know. Important Note: copying Symbol assets 

from the asset zip file into the Realm Studio assets directory does not create the 

collection.xml file for the symbols. You must use the Add/Update Symbol Collection 

dialog described previously to create the collection.xml file before the symbols are 

available to be used by Realm Studio. 

Importing Assets from the Wonderdraft User Folder 

If you have already purchased and installed Wonderdraft, Realm Studio is able to import assets 

from the Wonderdraft user folder. Selecting the Assets -> Import Assets From -> 

Wonderdraft User Folder... menu option will open a dialog similar to the Import 

Wonderdraft Assets dialog described in the previous section. 
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This dialog operates in almost the exact same way, also. 

1. Click the Folders button to open a Windows Folder Selection dialog that allows you to 

select the subfolders of the Wonderdraft user folder from which you want to import 

assets. Realm Studio automatically locates the Wonderdraft user folder and sets the 

default location of the Windows Folder Selection dialog to that folder. 

2. Select the Assets subfolder of the Wonderdraft user folder, then click the Select Folder 

button on the Windows Folder Selection dialog. 

3. Back in the Realm Studio Import Wonderdraft User Folder dialog, click the Import 

button. Realm Studio will find all the folders containing assets, and display them in a 

tree structure, as in the Import Wonderdraft Assets dialog. 

4. Select the folders holding assets you want to import, then click the Add button. Realm 

Studio will import the assets from the selected Wonderdraft folders into the Realm 

Studio assets folder. For imported symbol collections, you must still use the Create 

Symbol Collection dialog to complete importing Wonderdraft symbol collections into 

Realm Studio. Other types of assets don’t require any additional steps to make them 

available in Realm Studio. 
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The 3D World Globe View 
 

Realm Studio allows you to use the 3D Viewer to construct a dramatic scene and view your map 

as a world globe in space, animate the globe showing it rotating around its axis, and take a 

snapshot or record an AVI video of the scene with the world globe rotating in the scene. The 3D 

World Globe View has a lot of options to customize the scene, including adding clouds, 

displaying a local star (a sun or other main object), moons, a planetary ring, an atmospheric 

effect, and several video effects (blurring, bleach bypass, bloom, sepia toning, changing the view 

to grayscale). The video effects can be combined to create the look you want. 

To display the World Globe View, select Display World Globe from the Realm option on the 

Main Menu. This is how it looks when it is initially opened. 

 

When the World Globe View is displayed, your world map is converted to a texture (bitmap 

picture) and “wrapped” around the sphere that represents your world. The math used to wrap a 

rectangular picture (your map) onto a sphere works best when the picture is “equirectangular;” 

that is, when it is twice as wide as it is high. The Realm Configuration dialog has a couple of 

map size options (2048 x 1024 and 2048 x 4096) that are equirectangular, so that map you 

create will wrap onto a sphere minimizing visible problems. Maps that are not equirectangular 

will typically leave an obvious seam when wrapped onto the globe. 
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The controls in the Model, Camera, and Scene panels work the same way as they do in the 3D 

Viewer. The controls in the World Animation panel are specific to the World Globe view, and 

that panel is only displayed when the World Globe view is shown. 

Creating the World Globe Scene 
 

To begin creating a World Globe scene, you start with your map. Set the background texture 

and color, the ocean texture and color, and paint your landforms. You can use the landform 

generation function to quickly create landforms or modify the landforms you’ve painted. Apply 

shading and color to the landforms to create areas of mountains, vegetation, and snow and ice. 

Placing symbols on the map will usually not look very good, as they are 2D images, and don’t 

look right on a 3D globe. Use color and shading to indicate areas of mountains, deserts, forest, 

etc. rather than symbols. 

After opening the World Globe View, you can begin creating the scene. Starting from this basic 

map: 
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The World Globe View will start out looking like this: 

 

If you want to rotate the World Globe or see it from other angles, you can use the mouse to click 

and drag the globe within the view. Click the Change Axis button to change the axis of rotation. 

When the Z axis is pointing up, holding down the right mouse button and dragging the mouse 

will rotate the globe around its center. 

Note that in the initial rectangular map, the polar ice caps appear much larger than they do on 

the globe. This is caused by the distortion required to display a spherical globe as a rectangular 

map. You can see the same effect when viewing a rectangular map of the Earth. Greenland, 

since it is close to the North Pole, appears much larger than its actual size, which you can see 

when looking at a globe of the Earth. Keep that in mind when painting your landforms. Ice caps 

or land areas close to the northern and southern poles of your world will have to be drawn much 

larger than you might think to appear correctly on the World Globe View. 

Once you have the World Globe looking the way you want, you can create a dramatic scene of 

your world floating in space. Start by adding a background to the scene. 

1. Click the Scene Texture button in the Scene panel. 

2. A File Open dialog will open that lets you select a background texture (picture). 

3. Realm Studio includes several starfield textures in the Assets/Textures/Starfields 

directory. You can choose one of those, download one, or paint your own. 

4. Select the texture for the background that you like, and it will be displayed behind your 

world globe. It might look like the following: 
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After setting the background texture of the World Globe scene, you can click the Clouds button 

to add a cloud texture to the world. You can choose the default cloud texture, which are from the 

NASA Blue Marble photos, or choose custom cloud textures in the Assets/Textures/Clouds 

folder, or cloud textures that you download or paint yourself. The Clouds panel lets you change 

the opacity and tint/color of the cloud texture, so if you want to create the look of toxic green 

clouds of poisonous gases, you can do that! You can also can the rotation rate of the clouds, so 

they can appear to be moving faster or slower than the world is rotating. The following picture 

shows the World Globe with NASA Blue Marble clouds applied. 

 

Click the Clouds button again to close the Clouds panel. 
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Clicking the Features button will open the Features panel. The Features panel has tabs you can 

click to display controls for adding various features to the scene, like a local star, an 

Atmospheric effect, several visual effects implemented by GPU shaders (blur, bleach bypass, 

bloom, sepia tone, and grayscale), and to add one or more moons orbiting your world. 

Rather than going over all the Features in detail, you are encouraged to experiment to 

understand what they do and how they affect the look of your scene. Here are some pictures of 

the previous scene with a local sun and a moon added and various effects applied. 

The scene with no effects applied: 

 

The scene with a blur effect: 
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The scene with a cinematic bleach bypass effect applied: 

 

The scene with a bloom effect: 
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The scene with a sepia tone effect: 

 

And finally, the scene with a grayscale (black and white) effect applied: 
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The various effects can be combined to achieve a unique look, like this one combining bleach 

bypass, bloom, and sepia toning: 

 

You can experiment with the effects and combinations to achieve the look you want. Some 

combinations result in weird effects or for the scene to go completely white, so try different 

combinations and strengths (using the sliders) to find the right look. 

Taking a Picture of your Scene 
 

Use the Camera button to take and save a picture of your scene as it is currently shown. A file 

dialog will open, allowing you to choose the format and name of the picture. The scene will be 

saved in the format and with the name you choose. Here’s the previous scene saved as a PNG 

file: 
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Recording AVI Video of the Scene 
 

Realm Studio lets you create a video of your scene with your world globe rotating in space. Just 

click the green Record button, and an AVI video of your world rotating in space. All the effects 

that you’ve applied to the scene and other changes (local star, planetary ring, moons) are 

recorded in the video. The progress bar at the bottom of the view and a frame counter let you 

know the progress of the video. 

When you click the Record button, the button turns red and changes to a Stop button. You can 

stop recording at any time, but there is no functionality to resume recording once stopped. 

While the video is being recorded, all the controls on the 3D World Globe View are disabled, 

other than the Stop button, so the scene cannot be changed while video is being recorded. 

To preview what the video will look like, you can click the Enable Rotation switch. The scene 

will display the World Globe rotating without recording video. 

By default, Realm Studio will record a video with one full rotation (360 degrees) of your world, 

at 60 frames per second (3600 total frames). You can change the rotation rate to speed up or 

slow down the rotation speed of the world and change the frame rate using the controls. 

If you stop recording the video before all frames have been recorded, you can save the partial 

video. Realm Studio will present a message box asking if you want to save it. Choose Yes, and a 

File Save dialog will be shown allowing you to save it. 

When all frames have been recorded, Realm Studio will present a File Save dialog allowing you 

to save the complete video. At this time, the video can only be saved in AVI format. Other 

options might be implemented (like MPEG or GIF) in the future. If you need the video in other 

formats, there are many tools available for converting from AVI to other formats. 

Viewing Other Worlds 
 

The primary purpose of the 3D World Globe View is to show your world map as a world globe; 

however, the 3D World Globe View can wrap any equirectangular texture onto the sphere, so 

you can view any planet or star in the viewer, if you have an equirectangular picture of it. 

Clicking the World Texture will open a File Open dialog to select the picture you want to show 

as a globe. You can download pictures, paint your own, or use one of many included in the 

Assets/Textures/Planet folder 

A Final Note on the 3D World Globe View 
 

There is no function currently to save the scene you have set up. If you close the 3D World Globe 

View before you have taken the snapshot(s) or recorded the video you want, you will have set up 

the view again. A function to save the scene may be implemented in a later release. 
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Copyright and Licensing Information 
 

Realm Studio is licensed under the GNU Public License (GPL) 3.0. The full text of the license is 

available in the source code in the LICENSE.txt file and in the LICENSE.rtf file, and on the 

GNU website at https://www.gnu.org/licenses/. 

All the Realm Studio source code and documentation (including this file) is copyright ©2025 by 

Peter R. Nelson. 

 

Technical Information 

Realm Studio Implementation 
 

Realm Studio is a Windows Forms (Winforms) application written in C# using Visual Studio 

2022. The C# language version is 13.0. For graphics rendering, it uses the SkiaSharp 

implementation of the Skia graphics engine (version 3.116.1 as of this writing). Graphics 

rendering is accelerated by using the SkiaSharp SKGLControl, which is a Skia layer on top of 

the OpenTK.GLControl. OpenTK is an OpenGL library that allows for accelerated graphics 

rendering using the computer GPU. 

Realm Studio also makes use of the AForge, Clipper2, and Delaunator libraries for some of the 

more complex geometry operations, as well as my own implementation of the Moore-

Neighborhood algorithm for quickly finding the boundaries (contours) of landforms and water 

features. It uses the SimplexNoise library for creating simplex noise when generating random 

landform and water feature shapes. 

Realm Studio uses icons from Font Awesome (via the FontAwesome.Sharp library) throughout 

the application, and libraries from Cyotek for creating the color selection dialog. It uses controls 

from Real.Taizor to create a more modern (and hopefully more attractive) appearance for the 

application than a typical Windows Forms application. 

Logging is implemented using the Apache log4net library. 

Realm Studio requires .NET 8.0 to run. The minimum Windows version is Windows 10 (version 

10.0.26100.0). The Realm Studio installer will install the .NET libraries on your computer if 

they are not already installed. 

  

https://www.gnu.org/licenses/
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The Layers of a Realm Studio Map 
A Realm Studio map is constructed from 29 layers that are composited to create the final map. 

The layers are defined in code like this: 

        public const int BASELAYER = 0; 
        public const int OCEANTEXTURELAYER = 1; 
        public const int OCEANTEXTUREOVERLAYLAYER = 2; 
        public const int OCEANDRAWINGLAYER = 3; 
        public const int WINDROSELAYER = 4; 
        public const int ABOVEOCEANGRIDLAYER = 5; 
        public const int LANDCOASTLINELAYER = 6; 
        public const int LANDFORMLAYER = 7; 
        public const int LANDDRAWINGLAYER = 8; 
        public const int WATERLAYER = 9; 
        public const int WATERDRAWINGLAYER = 10; 
        public const int BELOWSYMBOLSGRIDLAYER = 11; 
        public const int PATHLOWERLAYER = 12; 
        public const int SYMBOLLAYER = 13; 
        public const int PATHUPPERLAYER = 14; 
        public const int REGIONLAYER = 15; 
        public const int REGIONOVERLAYLAYER = 16; 
        public const int DEFAULTGRIDLAYER = 17; 
        public const int BOXLAYER = 18; 
        public const int LABELLAYER = 19; 
        public const int OVERLAYLAYER = 20; 
        public const int FRAMELAYER = 21; 
        public const int MEASURELAYER = 22; 
        public const int DRAWINGLAYER = 23; 
        public const int VIGNETTELAYER = 24; 
        public const int SELECTIONLAYER = 25; 
        public const int HEIGHTMAPLAYER = 26; 
        public const int WORKLAYER = 27; 
        public const int WORKLAYER2 = 28; 

File Formats 
Realm Studio stores maps, themes, collections, and all its other data as XML. You can examine 

and edit the files using a text or XML editor, but it is not recommended that you directly edit 

any XML file created by Realm Studio, as irrecoverable damage can easily be caused. Realm 

Studio map files (those with a .rsmapx extension) are complex. Editing them with a text editor 

or an XML editor is likely to render the map unreadable by Realm Studio, potentially causing 

you to lose a lot of work. 

Boxes 

Boxes used as frames for labels have two parts: The .png file containing the image for the box 

and an XML file that includes the path to the.png file, a path to itself, and a series of tags 

defining the “center” of the box. The data for the center of the box is required, because boxes are 

drawn as “nine-patch” images, which allows them to be drawn at different sizes while 

minimizing the pixelation and distortion usually seen when bitmaps are drawn at different 

sizes and aspect ratios than for the original image. The box XML looks like this: 

<?xml version="1.0" encoding="utf-8"?> 
<mapbox xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns="RealmStudio"> 
  <BoxName>Avoro (1) Celtic</BoxName> 

https://en.wikipedia.org/wiki/9-slice_scaling
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  <BoxBitmap> 
    <Palette /> 
  </BoxBitmap> 
  <BoxBitmapPath>RealmStudio\Assets\Boxes\Avoro (1) Celtic.png</BoxBitmapPath> 
  <BoxXmlFilePath>RealmStudio\Assets\Boxes\Avoro (1) Celtic.xml</BoxXmlFilePath> 
  <BoxCenterLeft>11</BoxCenterLeft> 
  <BoxCenterTop>11</BoxCenterTop> 
  <BoxCenterRight>11</BoxCenterRight> 
  <BoxCenterBottom>11</BoxCenterBottom> 
</mapbox> 

 

When the box XML is first loaded by Realm Studio, the paths are rewritten to include 

the full path to the .png and XML files. 

Frames 

Frames, like boxes, are rendered as nine-patch images and are represented to Realm Studio in 

the same way as boxes. They also have two parts: The .png file containing the image for the 

frame and an XML file that includes the path to the.png file, a path to itself, and a series of tags 

the “center” of the frame. 

<?xml version="1.0" encoding="utf-8"?> 
<mapframe xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns="RealmStudio"> 
<FrameName>Arrow_frame_color</FrameName> 
<FrameBitmapPath>RealmStudio\Assets\Frames\Arrow_frame_color.png</FrameBitmapPath> 
<FrameXmlFilePath>RealmStudio\Assets\Frames\Arrow_frame_color.xml</FrameXmlFilePath> 
  <FrameCenterLeft>511.5</FrameCenterLeft> 
  <FrameCenterTop>511.5</FrameCenterTop> 
  <FrameCenterRight>511.5</FrameCenterRight> 
  <FrameCenterBottom>511.5</FrameCenterBottom> 
</mapframe> 
 

 

Label Presets 

Label presets are XML files containing the data needed to set the font, font color, and other 

characteristics of a label. The XML file also contains the name of the Theme associated with the 

preset. Because different themes may contain label presets with the same name, the label 

preset XML files are named using a GUID. A label preset XML file looks like this: 

<?xml version="1.0" encoding="utf-8"?> 
<LabelPreset xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" IsDefault="true" xmlns="RealmStudio"> 
  <LabelFontString>Palatino Linotype, 36pt</LabelFontString> 
  <PresetXmlFilePath>Realm Studio\Assets\LabelPresets\9bccb3a6-a5c2-446a-9420-
03463498b637.mclblprst</PresetXmlFilePath> 
  <LabelPresetName>Region</LabelPresetName> 
  <LabelPresetTheme>Medieval Quest</LabelPresetTheme> 
  <LabelColor>-1158551863</LabelColor> 
  <LabelOutlineColor>-2127155679</LabelOutlineColor> 
  <LabelOutlineWidth>2</LabelOutlineWidth> 
  <LabelGlowColor>-1</LabelGlowColor> 
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  <LabelGlowStrength>0</LabelGlowStrength> 
</LabelPreset> 
 

Name Generators and Name Base Files 

Name Generators are comma-separated values (.csv) files with two columns. When generating 

names, a randomly selected value from each of the two columns is combined to create the 

random name. Each entry in the first column of the contains a “%” character. When combining 

values from the first column and second column, Realm Studio replaces the “%” character in the 

selected entry from the first column with the random selection from the second column. 

Realm Studio has extended this basic functionality by allowing Name Generator files with an 

empty second column. When the second column is empty, Realm Studio will generate a value 

from selected languages and replace the “%” character in the selected entry from the first 

column with the generated value from the selected languages. Generating names using the 

Bodies of Water name generator uses this method. 

Name Base files are text (.txt) files containing one or more lists of names, each of which 

preceded by a header that describes the language of the names, the minimum and maximum 

name length, what characters are repeatable, and the proportion of single-word names. Realm 

Studio does not make use of the information from the Name Base file header for name 

generation. It simply selects a random name from the list based on the languages selected in the 

Name Generator Configuration dialog. 

 

 


